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1 Safety advice

The system must only be used for microdissection as described in the manual.

Caution – use of controls or adjustments or performance of
procedures other than those specified herein may result in
hazardous radiation exposure.

Damage due to unauthorized use is not subject to warranties. Only persons
who have been properly trained should use the system.

Thoroughly read the security advice in section 1 of the manual
before operation.

1.1 Laser safety

This system contains a laser for microdissection. It complies with the following
international standard:

IEC 60825-1; Edition 2; 2007; Safety of laser products

A laser of class 3B is incorporated. When the laser casing is open, it presents
a potential risk. Any direct or reflected beam must not strike the unprotected
eye (do not look directly into the beam).

Laser class 3B: Laser products that are normally hazardous when
intra beam ocular exposure occurs including accidental short time
exposure. Viewing diffuse reflections is normally safe. Class 3B
lasers which approach the AEL (accessible emission limit) for class
3B may cause minor skin injuries or even pose a risk of igniting
flammable materials. However, this is only likely if the beam has a
small diameter or is focused. The system includes safety devices
to prevent laser interference with the user.
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1. SAFETY ADVICE

1.1.1 Radiation output

Due to the power losses determined by the lenses of the microdissection
system and the objectives of the microscopes the average power shall be
deemed to be nominal at the microscope work surface (i.e., at the membrane
slide/tissue surface).

1.1.1.1 Legacy CellCut Plus and SmartCut Plus

Laser radiation characteristics systems delivered until 2014 are listed in Ta-
ble 1.1.

Table 1.1: Laser radiation data of the CellCut Plus and SmartCut Plus until 2015

Average power (nominal) < 10 W

Pulse width < 1 ns

Repetition rate > 5 kHz

Wavelength 355 nm

Pulse energy (typical) > 0.5 µJ

1.1.1.2 CellCut

Starting from 2015 CellCut system are available in with three versions

• standard laser

• universal laser

• high power laser

1.1.1.3 standard laser

Laser radiation characteristics for CellCut systems incorporating a standard
laser are listed in Table 1.2.

1.1.1.4 universal laser

Laser radiation characteristics for CellCut systems incorporating a universal
laser are listed in Table 1.3.

2
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Table 1.2: Laser radiation data of the CellCut systems incorporation a standard laser

Average power (nominal) < 10 W

Pulse width < 1 ns

Repetition rate 2 kHz

Wavelength 355 nm

Pulse energy (typical) > 1 µJ

Table 1.3: Laser radiation data of the CellCut systems incorporation a universal laser

Average power (nominal) < 10 W

Pulse width < 1 ns

Repetition rate 4 kHz

Wavelength 355 nm

Pulse energy (typical) > 2 µJ

1.1.1.5 high power laser

Laser radiation characteristics for CellCut systems incorporating a high power
laser are listed in Table 1.4.

Table 1.4: Laser radiation data of the CellCut systems incorporation a high power
laser

Average power (nominal) < 10 W

Pulse width < 1.5 ns

Repetition rate 500 Hz

Wavelength 355 nm

Pulse energy (typical) > 70 µJ

3



1. SAFETY ADVICE

1.1.2 Laser safety labels

This system carries the following labels (Table 1.5), which meet the interna-
tional standard for laser safety IEC / EN 60825-1 and complies with 21 CFR
Part 1040.10 except for deviations pursuant to laser notice No 50, dated June
24, 2007.

Table 1.5: Laser safety labels

(1)

(2)

(3)

(4)

(5)

Explanatory label

Aperture label: Indicates 
accessible laser radiation 
during operation

Caution label: Human access 
to laser radiation: When 
housing is opened, class 3B 
laser invisible radiation is 
accessible

Warning label – Hazard symbol: 
System and Software (Monitor)

Identification label

AVOID EXPOSURE
LASER RADIATION
IS EMITTED FROM
THIS APERTURE

INVISIBLE LASER RADIATION

AVOID EXPOSURE TO BEAM

CLASS 3B LASER PRODUCT
(IEC / EN 60825-1: 2007)

15 mW at 355 nm

CAUTION - CLASS 3B
INVISIBLE LASER

RADIATION WHEN OPEN.
AVOID EXPOSURE TO BEAM

4
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REAR VIEW LEFT VIEW

TOP VIEW FRONT VIEW

(3)
(5)

(2)

(4)

(1)

(3)

(3)

(3) inside 
observation 

tube

Figure 1.1: Positions of laser safety labels
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1. SAFETY ADVICE

Viewing 
path

Laser 
beam

Laser access 
gap 1

Laser 
access gap 2

1
2

Filter 1: beam mirror
Filter 2: absorption filter

• Laser access gap 1: Access to 10 mW UV laser power, gap between
90–97 mm, depends on the z-position of the objective and condenser

• Laser access gap 2: access to 12 mW UV laser power, gap between
4–11 mm, depends on the z-position of the objective. This gap does
only exists in the legacy versions CellCut Plus and SmartCut Plus but is
covered in CellCut systems starting from 2015.

Figure 1.2: Laser access gaps
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1.1.3 Eye protection

A UV coated beam mirror (filter 1 in Fig. 1.2) and an additional UV absorption
filter (filter 2) is used with the eyepiece of the microscope to block and absorb
hazardous UV laser radiation. It is contained in the microscope stand. This
prevents the user coming into direct contact with laser radiation, even when
the binocular tube or eyepieces are removed.

The camera ports and the fluorescence filters in the fluorescence filter turret
are protected with the UV coated beam mirror (filter 1).

1.1.4 Microscope interlock

Interlocks are provided to protect you from eye injury resulting from accidental
exposure of the eye to the invisible UV laser beam during cutting of dissec-
tates.

Figure 1.3: Illumination pillar interlock

When you tilt the illumination pillar backwards the interlock mechanism switch-
es off the laser (Fig. 1.3).

On CellCut Plus and SmartCut Plus the LED 1 on the controller changes the
color from yellow to red, as shown in table ??.

On CellCut starting from 2015 the laser will be unpowered. The green, yellow
and red LED turn off as indicated in table 1.7a

7



1. SAFETY ADVICE

1.1.5 Remote interlock

1.1.5.1 Legacy CellCut Plus and SmartCut Plus

1

2

3

(a) Legacy distribution adaptor (b) Legacy door interlock plug.

Figure 1.4: Legacy distribution and interlock adaptors. (1) connector to controller.
(2,3) connectors to interlocks.

For the door interlock, connect the laser safety distribution adaptor (Fig. 1.4a)
to the rear of the controller. The distribution adaptor has an additional connec-
tion for a door interlock. This connector is delivered with a separate plug for
the cable of the door interlock.

To connect the door interlock (Fig. 1.4b), consult your laser safety representa-
tive.

• Unscrew the door interlock plug.

• Solder the two cables to the door interlock plug.

• Tighten the door interlock plug again.

When you open the door the interlock mechanism switches off the laser. The
LED 1 on the controller changes the color from yellow to red.

1.1.5.2 mmi CellCut

On the back of the CellCut electronics box, see 1.5, a remote internet plug is
available. One fitting connector will be delivered with your CellCut. You can
connect a door interlock and a laser warning lamp using that connector.

To connect a door interlock or a external warning lamp, consult your laser
safety representative. The detailed pinning of the connector is available from
your MMI service representative.

8
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Figure 1.5: Remote interlock plug delivered with mmi CellCut

1.1.6 Laser safety features of CellCut electronics

1.1.6.1 Legacy CellCut Plus and SmartCut Plus

1.1.6.2 mmi CellCut

The CellCut electronics consitst of the CellCut controller and the CellCut key
switch box. If the key switch box is not properly connected to the controller
box, the system will not turn on.

9



1. SAFETY ADVICE

Legacy laser controller Laser
status

Key
switch

Push
button

Interlock LED 1 LED 2

Off Off / On unlocked Off Off Off

On On locked Yellow Green On

On Off locked Yellow Off Standby

On On unlocked Red Green Standby

On Off unlocked Red Off Off

(a) Laser controller safety logic

(b) Legacy controller front panel

interlock
connector

(c) Legacy controller rear side

Figure 1.6: Laser safety functions of the legacy laser controller
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CellCut controller and key switch box Laser
status

Key
switch

Activation
button

Interlock LED 1 LED 2 LED 3

Off Off unlocked Off Off Off Off

Off Flashing locked Off Off Off Off

On Off locked Green Off Off Powered

On Off locked Green Slow
flashing

Off Heating
up

On Off locked Green Fast
flashing

Off Error

On Off locked Green Yellow Off Standby

On Off locked Green Yellow Red On
(a) CellCut safety logic

(b) CellCut front panel

(c) CellCut key switch

(d) Controller rear side

Figure 1.7: Laser safety functions of mmi CellCut 11



1. SAFETY ADVICE

1.1.7 Warnings

To ensure full safety of the system please follow the steps below:

• Turn off the laser with the key switch to prevent unauthorized operation
of the system.

• Ensure that the laser power is turned off with the key switch if any objec-
tives or blanks are to be removed from the objective turret.

• Ensure that all positions in the objective turret that do not contain an
objective lens are covered with blanks.

• Laser beam is invisible to the human eye (λ = 355 nm). Never stare into
the microscope objective while the laser is operating. Laser power up to
10 mW could be emitted through the microscope objectives.

• Invisible UV energy could exceed the maximum permissible exposure
(MPE) limits for the skin if a person reached into the gap between the
stage and the condenser during the cutting process. The exposure time
needed to exceed the MPE would depend on the distance above the
stage and the magnification of the objective.

• Use only objectives recommended by MMI for laser microdissection.

• Never place reflecting objects in the beam path.

• Viewing the laser output with certain optical instruments (for example
eye loupes, magnifiers, microscopes) will likely increase eye hazard.

• The laser source and the optical equipment are enclosed within the MMI
housing. Do not attempt to open the laser box or remove beam covers.
Laser power of up to 15 mW at 355 nm could be accessible in the interior
if a cover is removed.

1.2 Limits for Laser Energy

Skin Exposure Limit The skin Maximum Permissible Exposure (MPE) limit from
the IEC 60825-1 standard for irradiance at the laser wavelength is 1 mW/cm2

for an exposure of 1’000 s–30’000 s. That can also be expressed as 96 µW in
a 3.5 mm aperture. Higher levels are allowed for shorter time periods.

There is a potential for a skin exposure that exceeds the MPE in the volume
between the stage and the condenser, so the user is cautioned to avoid lengthy
skin exposures at that location, particularly for lower magnification objectives.
Due to the beam divergence, there is no potential exposure above the MPE
beyond the location of the condenser.
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Eye Exposure Limit The eye MPE limit from the IEC 60825-1 standard for ir-
radiance at the laser wavelength is 66 µW/cm2 for an 8-hour exposure at the
maximum expected 50% on-time duty cycle. Considerably higher levels are
allowed for shorter time periods or lower duty cycles (e.g., MPE = 1 mW/cm2

for a time period of 1000 s).

When the product is operated per the procedures in this manual, the con-
denser blocks any laser energy that could cause an eye exposure of persons
above the MPE limits during normal operation or routine maintenance. And
there is insufficient spacing between the stage and the condenser to allow a
direct eye exposure.

The following procedures that could result in an exposure that exceeds the
MPE limits should also be avoided: attempting to turn on the laser when there
is no slide in the beam path; turning on the laser with the turret at an open
position (e.g., without an objective or blank at that position); or inserting a
mirror into the narrow gap below the stage where a beam is present.

1.3 General safety

• Do not disassemble the system. The installation of the system is pro-
vided by MMI service personnel or a MMI designated representative.
Repairs, removal or exchange of components beyond the operations de-
scribed in this manual may only be carried out by MMI service personnel
or persons explicitely authorized by MMI to do so. If you have any prob-
lems with the instrument, contact MMI.

• The power supply is installed by MMI. MMI assures that the system is
provided with the appropriate voltage. Do not change the power cords.

• Avoid wet or dusty conditions near the system. If liquid gets inside the
system, do not attempt to use it. Contact MMI.

• Unplug all electrical supply before cleaning the system. Do not use
cleaning fluids or sprays; only use a smooth and dry cloth.

• If the stage control is not calibrated, stage movements can be sudden
and fast. Ensure that the working area around the stage is free of clutter
and material.

• Read the manual of your microscope for specific microscope precau-
tions. If you do not have the manual, contact your microscope provider
or MMI.
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2 Installation

The MMI system may only be installed by an MMI service engineer or our des-
ignated representative in the laboratory of the customer. After the installation
training will be provided in the use and operation of the system. The customer
should not change the installation of the equipment.

Should you want to move an installed unit, please contact MMI for assistance.
With any malfunction of the device, please contact our service department:

service@molecular–machines.com

After installation or modification of the MMI system, an authorized specialist
must perform a thorough check to ensure that the system is in perfect condi-
tion. If your system comprises a laser, it must be ensured that the laser safety
features are functioning correctly and that the covers to protect against laser
radiation are fitted.
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3 The mmi CellTools
instrumentation family

The mmi CellTools are a fully modular instrumentation family, including the
following components:

• mmi CellCut : laser microdissection to isolate single cells or areas of
tissue

• mmi CellManipulator : optical tweezers to manipulate cells or beads with
an optical trap

• mmi CellEctor : automated micro-pipetting to mechanically manipulate
cells or beads with a capillary and mechanical micromanipulator

• mmi CellExplorer : pattern recognition software for PC based image
analysis

Any or all of these modules can be combined in one microscopic environment.
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4 Getting started

4.1 Working principles

The mmi CellCut is used to isolate, under microscopic view, small areas or
single cells from histological sections for further microbiological analysis. Only
the cell(s) wanted for further investigation are cut out. DNA, RNA, as well as
proteins from undisturbed, pure samples can be investigated. No mechanical
contact is necessary for the laser microdissection of the samples. Thus the
method avoids contamination of the samples.

(a) Cryo or paraffin-preserved tissue (b) Single cells, smears or cytospins

(c) Chromosomes (d) Others, e.g. sperms, C. elegans

Figure 4.1: Sample preparation

For sample preparation from any source such as frozen or paraffin embedded
sections, smears or cytospins, and chromosomes spreads, the mmi CellCut
system uses the mmi Membrane Slides. This special frame slide is covered
with a thin membrane that is completely inert and has negligible auto fluores-
cence. The different types of samples are prepared on this membrane and
covered with a normal glass slide for protection against contamination.

Using the mmi CellCut software, the regions of interest are selected on the
display using either the mouse, by freehand or predefined geometrical shapes,
such as circles and squares (see Fig. 4.2).

Any number of areas across the entire slide can be identified as targets and
the sizes of the geometrical shapes can be changed as well as copied and
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Figure 4.2: Easy cell selection

pasted for consistency. A grouping function allows the user to collect an un-
limited number of different cells or cell areas within one screening process in
different mmi IsolationCaps.

The thin (0.3 µm at 100x) cutting path enables the precise and comfortable
extraction of the selected areas at an outstanding speed, without affecting its
morphology or otherwise negatively affecting the areas of interest. As a result,
there is no loss in quality of the material used in subsequent steps. Even the
viability of living cells is not affected and, therefore once selected, cells can be
recultured. Depending on the sample type, several thousands of cells can be
laser dissected in less than a minute.

Several areas of interest can be microdissected in one automated operation
and collected in the mmi IsolationCap. One mmi IsolationCap used for single
step collection can collect several dissections, even from different slides.

Figure 4.3: Post-processing: after dissection, the sample is resuspended in a buffer.

The mmi IsolationCap used with the mmi CapLift technology allows the col-
lection of target areas across the entire microscope slide.

After microdissection, the mmi IsolationCaps are snapped into the micro cen-
trifuge tubes to undergo extraction of the bio molecules (Fig. 4.3). After using
the recommended extraction reagents for the desired incubation time, the ex-
tracted targets are now ready for further genomic and proteomic processing.
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Figure 4.4: Schematic view of laser microdissection

4.1.1 System setup

The mmi CellCut system consists of a high performance research microscope
with motorized scanning stage, an electronically controlled, solid-state laser,
laser beam delivery and transfer optics and a high-end workstation with Mi-
crosoft Windows and the sophisticated control software mmi CellTools.

All usual microscope features are available. The mmi CellTools software con-
trols the laser, image capture, and scanning stage actions without blocking
any other microscope action.

4.2 Handling of samples

4.2.1 Single-step collection using the mmi IsolationCap

Microdissection for the isolation of cells is only useful if you can remove the
parts of the tissue you are interested in from the surrounding tissue and from
the slide. The single step collection makes sampling of one or several isolated
areas easy and contamination-free.

The single step collection uses a protective membrane and a reaction tube
with a special adherent lid.
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The purpose of the protective membrane is

• to avoid contamination of the sample; and

• to facilitate easy removal and collection of the cut area.

The laser cuts through the tissue and the membrane from below the stage.
The separated tissue together with the membrane is collected on the lid of the
reaction tube.

The laser cuts around the selected cells to be isolated. No additional radiation
is used for the collection step.

The membrane and the adhesive lid are chemically inert and have no influence
on further molecular biological processing. The membrane material is a thin
PET membrane. The membrane is transparent and does not perturb the light
beam.

The lid of the reaction tube also contains a diffuser insert. The diffuser insert
improves the image quality remarkably and can be placed directly on top of
the tissue and the membrane during all operations.

4.2.2 Preparation of slides

The Single Step Collection of the dissection requires special slides. The slides
are provided with a 1.4 µm thick, clear PET membrane.

(a) Assembly of the reversed metal frame
and a glass slide (1.0 or 0.17 mm)

(b) The assembled sandwich is protected
against contamination.

Figure 4.5: Slide preparation

The tissue is mounted on the flat side of the membrane slide, just as on an
ordinary slide. After the usual processing the membrane with the tissue is
inverted and placed onto a new glass slide and fixed in position on the micro-
scope stage.

Thus the tissue is now under the membrane and protected against contami-
nation.
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4.2.3 Preparation of live cells

This section gives a brief overview of options when working with CellCut on
live cells. Detailed instructions can be found in the Live Cell Protocol, which
can be found on the CellTools installation media.

The standard live cell microdissection disposable, the mmi CellChamber, con-
sists of an inner stainless steel ring with a membrane at the bottom, in which
the live cells can be cultured.

(a) mmi CellChamber (b) Extracting tissue from live cell cultures

Figure 4.6: Live cell dissection

Prior to microdissection, the mmi CellChamber is placed in a sterile Petri dish,
coated with an adhesive bottom. To isolate live cells, the Petri dish is placed
on the microscope stage.

Areas of interest can be positively or negatively selected and microdissected
by the laser without any need to open the dish or drain the growth medium.
The laser quickly and precisely cuts only the membrane to enable easy sepa-
ration of the adherent targeted live cells.

During this process, the cell cultures can remain in their growth medium with
no laser energy focused on them during the isolation. This workflow mini-
mizes the risk of loosing viability, either by stress generated by laser light or
by environmental conditions.

There is a new option for high throughput live cell handling with mmi Isolation-
Cap technology together with 18-well IBIDI slides.

Through this new method of extracting cell cultures, MMI accomplished an
improved sectional view and increased cutting efficiency. At the same time
it also allows the use of the mmi IsolationCap technology with its known and
proven advantages. This guarantees contamination-free and careful handling
of the cells.

To receive more information about further applications, please order the mmi
Tutorials.
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Figure 4.7: Using 18-well live chamber slides for microdissection

4.3 Quick start

The mmi CellTools software together with the mmi CellCut plug-in provide all
necessary controls for:

• displaying live video

• saving images and videos

• motorized xy-stage

• adjusting the laser power, speed and focus

• storing the preferred camera settings

• manipulating the automatic cap lift

• manipulating the optional multi cap lift and multislide

• optional handling of motorized microscopes

This results in an easy and user-friendly method for:

• scanning the sample

• documenting the sample

• marking the path for the laser cutting around single cells or cell clusters

• marking several areas to be cut in one operation

• storing the marked cutting paths (for later cutting)

• dissecting the marked sample areas automatically

• collecting the dissected areas without radiation or risking contamination
of the isolated material(s)
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The operation of all modules is controlled by the easy-to-use mmi CellTools
software. The main application is responsible for displaying the video, saving
the image, adjusting the camera control and basic xy-stage movement.

The mmi CellCut plug-in adds the specific mmi CellCut functions module. Ad-
ditional plug-ins for mmi CellManipulator, mmi CellEctor and mmi CellExplorer
are available.

4.3.1 System startup

To start mmi CellCut follow the steps below:

1. Start up the PC and allow the boot process to complete.

2. Turn on the microscope white light power supply.

3. Switch on the CellCut controller by turning the key.

4. Start mmi CellTools software and wait until the software has finished the
start up and self-test procedure.

5. Power ON the laser by pressing the button on the key switch box (CellCut
II) or controller electronics box (CellCut Plus and SmartCut Plus).

Figure 4.8: The CellTools startup banner

4.3.2 Handling a new slide

Prepare your sample as described in chapter 4.2 or follow the detailed appli-
cation notes provided by MMI and mount it on your microscope.

Take care that the stage geometry is properly defined and the stage calibration
is valid, see section 5.5.

Use the objective with the lowest magnification (4x on most systems). By
clicking on the scan button the software creates an overview of the sample.
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By double clicking on the overview you can navigate to the area of interest. You
can also use the cursor keys to move the stage or drag the flashing rectangle
in the slide overview with the mouse.

Move the cap lift down by clicking on the corresponding button or press F2.
After lowering the cap lift you should adjust the microscope stage fine focus,
as needed.

Activate any button in the toolbar with a mouse click. For example the free-
hand drawing tool enables the user to draw a line around the object to be
microdissected.

Press the cut button to microdissect the selected object.

Lift the cap holder to collect the microdissected sample.

Now remove the cap and proceed with the application.

4.3.3 System turn off

Shut down mmi CellTools by selecting the menu item

Project→Exit

or by clicking the main window’s close button.

Shut down the laser controller by pressing the button to deactivate the laser
and then turn the key to the OFF (vertical) position to switch off the electronic
controller.

Shut down the computer.
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5 mmi CellTools – Main
application

5.1 Main window and plug-ins

Fig. 5.1 shows the extended tool area and explains the main components of
the mmi CellTools user interface.

mmi CellTools

active
application

user database common tools

live
video
panel

application
panel

slide
overviewstatus messages

microscope
panel

Figure 5.1: Structure of the mmi CellTools user interface

The major portion of the window is occupied by the live video panel, which
displays the current field of view of the microscope and serves as the main
area for interaction between the user and the system.

mmi CellTools is a single piece of software that controls all micromanipulation
devices of the mmi instrumentation family (see chapter 3). The instrument-
specific controls are located in the application panel. Switch between appli-
cations using the tabs at the top.
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Those user interface controls that are common to all applications are located
in the tool bar at the top of the window. The user database controls provide
access to instrument parameters for specific samples, for certain imaging sit-
uations, and for each objective (see section 5.2). The remaining common
tools on the tool bar provide elements for camera and stage control.

On systems equipped with an automated microscope, the microscope panel
provides access to z-drive (focus) control and other microscope-specific fea-
tures (see chapter 7). The slide overview panel provides controls for slide
scanning and navigation (see section 5.4.4). Finally, the status messages
bar at the bottom displays current stage coordinates and camera frame rate.

To accommodate for left-handed users, the application and microscope panels
can be moved to the left-hand side using the menu item

Edit→Left-handed UI

5.2 User-specific database

All settings saved in the mmi CellTools are unique to the current user logged
in. mmi CellTools fully supports Microsoft Windows user management. During
program startup the last settings saved by the active user are loaded.

The database represents a hierarchical structure:

Slide =⇒ Setup 1 =⇒ Objective 1
=⇒ Objective 2

...
=⇒ Setup 2 =⇒ Objective 1

=⇒ Objective 2
...

...

Basically the user can save all parameters for each experiment (Slide) he/she
runs separately. If the user changes settings for an experiment, settings from
recent experiments are still saved and accessible.

The Setup represents all necessary parameters to define an illumination meth-
od (bright field, fluorescence, DIC. . . ). If you change a parameter in a setup,
the change will only be reflected in the current slide.

The Objective represents all objective related settings and calibrations. If you
change an objective calibration or objective related parameter, the change only
will be reflected in the current setup and slide.
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5.2.1 Slide editor

The slide selection box contains all samples you defined in the past. All doc-
umentation is saved under this name. To change the database open the slide
editor (Fig. 5.2) by pressing the edit button.

Figure 5.2: Slide editor

Use the + button to define a new slide. All parameters from the active slide
will be copied. Rename the slide by clicking on the name. Use the − button to
remove the active slide.

5.2.2 Setup editor

The setup selection box contains all parameters defined for the active slide. To
add, remove or change the database press the edit button. To use this editor
follow the same steps as for the slide editor described above. If you create a
new slide all setups will automatically be copied from the active slide.

Figure 5.3: Setup editor
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If you run different types of experiments, e.g., microdissection with bright field,
microdissection with fluorescence, or optical tweezers it is recommended to
define one setup for each of these experiments.

To rename the defined setups click on the setup name and type in a different
name.

The Filterblock, Condenser and Opticalpath settings are only used with mo-
torized microscopes. The use of these parameters is explained in section 7.2.

If your system is equipped with more than one camera, different setups can
be associated with a certain camera. You can then switch to a specific camera
by selecting a setup defined for that camera.

The camera associated with a setup is displayed in the setup editor (column
Camera) and can be changed by clicking on the name. The camera used
should also be reflected in the setup name. On single-camera systems you
should normally select “<default camera>”.

5.2.3 Objective editor

The objective selection box contains all objectives defined for the active setup.
To change the database, press the edit button to open the objective editor
(Fig. 5.4). To use this editor follow the steps for the Slide Editor described
above. If you create a new setup, all objectives will automatically be copied
from the active slide.

Figure 5.4: Objective editor

To rename the defined objective click on the objective name and type in a
different name.

The Nosepiece and Lamp Voltage settings are only used with motorized mi-
croscopes.

If specified, Nominal magnification will be used to compute various objective-
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dependent properties (e.g. laser focus, see section 6.2.3.2).

In addition to the parameters displayed in the Objective Editor window, the
following information is stored separately for each objective:

• Camera settings (see section 5.3.2)

• Field of view dimensions from camera alignment (see section 5.7.1)

• Lens offset (see section 5.7.2)

• Z-Focus lens offset (see section 7.4.3) (for automated microscopes only)

• Cutting parameters (see section 6.2.3)

• Laser position (see section 6.7.1)

If one of these settings is not correct, please refer to the corresponding chap-
ter.

5.2.4 Default database reconstruction

Each user handles his/her own database. Changes in this user-specific data-
base will not be visible for any other user.

A default database is always stored separately in a central file location. This
default database is specific for your instrument and will be set up and handled
only during installation and service.

If for some reason, a user’s database becomes unusable, the user can recover
the default database by the following procedure:

Procedure

1. Close mmi CellTools

2. Delete the following folder from the hard disc:

C:\Users\username\AppData\Roaming\MMImCUTDataBase

or for Windows XP Systems:

C:\Documents and Settings\username\Application Data\

MMImCUTDataBase

3. Open mmi CellTools

The default database will automatically be recovered and is directly visible in
mmi CellTools.
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You will lose all slide and setup data contained in the user
database. You will need to recalibrate the entire system.

5.3 Camera operation

mmi CellTools supports a range of scientific digital cameras, supplied by MMI
or third parties:

• The mmi CellCamera range of digital cameras for general microscopy
applications

• The Andor iXonEM EMCCD camera for ultra-sensitive detection

5.3.1 Multiple cameras

mmi CellTools also supports multiple cameras. If more than one camera is
connected to the system, switch between the cameras by selecting a setup
dedicated to that camera.

To define the camera used by a setup, open the setup editor and click on the
camera field showing <default camera> as default. A drop down list shows
up in which you simply select the camera to connect to that setup.

Do not use the setup editor to switch between cameras. The setup
editor is only used once to create (at least) one setup for each
camera. Then, change cameras by selecting the corresponding
setup.

5.3.2 Camera settings

For best imaging results the camera can be controlled through a settings win-
dow (Fig. 5.5). To open it, click the camera button in the toolbar or select

Video→Camera settings

from the menu (Ctrl + R).

Image exposure is controlled through the top elements in the dialog. Unless
Automatic exposure is selected, the exposure time can be controlled through
the Exposure time slider or the adjacent input field. In Automatic exposure
mode the slider is inaccessible. If the auto-exposed images are too bright or
too dark, use the Exposure correction slider to compensate.
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Figure 5.5: Camera settings for mmi CellCamera models

Finally, the amplifier Gain can be adjusted to yield brighter, but noisier images.
Higher gain settings will, however, reduce the required exposure time. For high
quality images (e.g. for publications) it is preferable to use a longer exposure
time and low gain. Note that the allowed gain range is greater when automatic
exposure is off.

The controls in the bottom part of the dialog allow control over color and con-
trast. Use the Gamma slider to control image contrast. The default Gamma
value is 0.75, and it may be adjusted over a range of 0.01 to 2.0. Low gamma
values are recommended especially to brighten low light fluorescence images.
High gamma values reduce noise and improve the black level of the image.

The camera Mode provides color settings optimized for various applications.
For bright field, the color quality can be optimized with the Best image mode.
The camera transfers a high quality YUV4:4:4 data stream with full pixel reso-
lution. By selecting Fastest rate, the image rate (frames per second, fps) will
be maximized. In this mode up to 20 fps (depending on your camera model)
with full pixel resolution are displayed. For fluorescence applications, the con-
trast can be optimized with the Low light option. The camera transfers a high
quality RGB data stream with full pixel resolution. This setting is used mainly
in combination with the Gamma and Gain setting. If you select Binning, the
camera operates at a lower resolution, but yields brighter black and white im-
ages at a very fast frame rate.

Color shifts, mainly caused by changes in lamp brightness, can be corrected
using the white balance function. To set the white balance, first locate an
empty, transparent part on the sample slide, then click the Set white balance
button. If the image is too bright or too dark the white balance fails.

The white balance function is also available in the drop down menu next to the
camera button, in the main menu under
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Video→Adjust white balance

or using the keyboard shortcut Ctrl + W .

Do not use the Set white balance option in fluorescence imag-
ing.

All camera settings, including white balance, are stored separately for each
objective. This eliminates the need to adjust the camera after each objective
change. Optionally, the software uses a single white balance setting for all
objectives. This is recommended for non-automated microscopes. Select

Video→Save white balance per objective

to enable or disable this function.

5.3.3 Freeze video / live video

In fluorescence applications it makes sense to freeze the video when you have
acquired a good image. After freezing the video you can close the fluores-
cence shutter and go ahead with drawing and cutting your dissectates without
further photo bleaching of the fluorescence dye.

To freeze the video use the menu item

Video→Video freeze

To go back to live video presentation select

Video→Video live

5.3.4 Saving images

To save an image simply press the Save image button, use the menu item

Video→Save Image

or press Ctrl + S.

The file dialog allows you to specify the image filename and image type (JPG,
BMP, PNG and TIF). The image will be saved with maximum pixel resolution.
By selecting the Include drawings check box you can save a screen shot
from the current video image including all markers and drawings.
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When saving images with drawings, the system will produce a
screenshot from the live video area, resulting in reduced pixel res-
olution of the saved image.

Press the Copy image to clipboard button to make the current image avail-
able to other applications. The image will be copied to the Windows clipboard
in order to paste it into e.g. office and image processing applications. The
same result can be seen with the menu item

Edit→Copy Image

The Include drawings does not affect the Copy image to clip-
board function. The clipboard always receives the original camera
image without drawings.

5.3.5 Recording movies

mmi CellTools allows you to record live camera images into video files (AVI
format). It supports compressed and lossless video codecs and allows you to
record time-lapse movies.

Figure 5.6: Movie recording functions in the tool bar

Click the Record button to start recording a new movie. CellTools will auto-
matically create a new AVI file in the movie folder and record video until you
press the Stop button. If Auto-open is enabled (see below), the movie will
open in Media Player immediately after recording. Otherwise, you can access
recorded movies through the drop-down menu items Playback (open in media
player) and Open movie folder.

By default, the movie folder is located in

My Documents\mmiCellTools\Movies.

Movies are compressed with a video codec, currently either Win-
dows Media Video 9 or XVID. To play back those movies, your
computer will require installation of the same codec. Codecs are
found on the mmi CellTools installation media.

Also note that any shapes drawn will not be recorded.
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5.3.5.1 Movie settings

Detailed aspects of movie recording can be controlled by opening the Movie
settings dialog (Fig. 5.7).

Figure 5.7: Movie settings

The Encoding specifies the format (codec) to store the video frames. Ta-
ble 5.1 gives an overview of available encodings and their application.

Table 5.1: Movie encoding options

Encoding method Image quality Recommended for
Uncompressed Lossless Short videos

Extracting frames in full quality

Compressed – Windows
Media Video (default)

Lossy General use
Playback primarily on Windows
systems.1

Compressed – XVID Lossy Color video (not usable for black and
white cameras)
Playback on any system with XVID
codec installed

To create basic time lapse movies only adjust the Time lapse factor as de-
sired. This factor defines the speed at which the movie will play back. Enter
“1x” to turn off time lapse (standard time).

The Playback rate specifies at how many frames per second the final video
should be played back. (This is identical to the recording rate unless using
time lapse.) The default playback rate is 10 Hz and should be suitable for
general use.

The Recording interval specifies the minimum time interval between two
recorded video frames. The recording interval is computed from time lapse
factor and playback rate and is for information only.

1To play back Windows Media Video files on Mac OS X, install Windows Media Player for
Mac OS (Flip4Mac), which is downloadable from the Microsoft website.
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Depending on the current camera settings and available computer
hardware it may not be possible to achieve very short recording
intervals.

To control the rates at which frames are recorded and played back, change
the Playback frame rate. If time lapse is off, the movie is played back at the
same rate at which it was recorded. When using time lapse, the recording
rate is automatically adjusted. The dialog displays the recording interval, i.e.
the time elapsed between two frames. This interval significantly influences the
size of the resulting video file.

The Movie folder input field allows you to specify the destination folder where
movie files are saved. For maximum performance, this should not be a net-
work folder. Check the Open movie after recording option to have movies
automatically open and playback in Media Player after recording.

5.4 Motorized stage control

The movement of the motorized stage is controlled by the mmi CellTools soft-
ware.

5.4.1 Mouse movement

Choose the move mode by clicking the hand tool button. You can reach the
same functionality by pressing the right mouse button with the cursor in the
video window. A menu pops up and you choose Move stage with a left mouse
click.

In the move mode the cursor in the video panel always appears as a hand.
By clicking and dragging the left mouse button, the stage directly follows the
mouse movement.

If stage movement does not exactly follow mouse movement, you
may need to carry out the camera alignment procedure (see sec-
tion 5.7.1).

You can quickly switch to move mode and back again by pressing Space.

5.4.2 Keyboard movement

The main arrow keys and numeric pad arrow keys can be used to move the
stage in discrete steps or continuously at constant velocity (Fig. 5.8).
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Figure 5.8: Stage movement using the keyboard

A single press of a cursor key moves the stage by a defined distance. By
default, this is 10% of the screen for the cursor keys and 90% of the screen for
numeric pad keys.

NumLock must be turned on for numeric cursor keys to work as
expected.

For moving larger distances, hold down the respective key. The velocities for
the two sets of movement keys can be set independently (see section 5.4.3).
By default, the cursor keys move slowly and the numeric pad keys move fast.

In applications where you need movement by well-defined distances only, the
continuous movement can be suppressed by enabling Caps Lock .

5.4.3 Stage movement settings

To change stage movement settings, press the Stage movement settings
button, click the menu bar item

Stage→Movement settings

or press Ctrl + P to get the window in Fig. 5.9.

Acceleration This value determines the stage motors’ acceleration for both
keyboard and mouse movement.

Reducing this value may facilitate the handling of liquid suspension sam-
ples. For all other samples we recommend using 100%.

Units For the arrow keys on the keyboard you can set the stage settings in
two different units:
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Figure 5.9: Stage movement settings

• Screens (or percentage of screen)

• Micrometers (µm)

When using micrometer units, note that you may have to adapt distances
with every objective change.

Distance and velocity These values can be chosen independently for cursor
and numeric pad keys. By default, cursor keys are used for minor steps
and numeric pad keys for major steps.

Values that are outside the allowable range will be shown in red.

5.4.4 Overview scan

Fig. 5.10 shows an overview of your sample (the “roadmap image”).

Figure 5.10: Slide overview

The overview scan is started by pressing the Start scan button. If no area of
interest is defined, the maximal scan area will be used. The maximum scan
area is:

• the inner part of a mmi MembraneSlide

• the square around a petri dish
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• the square around the cap of a single cap holder

• the square around the well of a custom grid, if only one well is defined.

• the complete slide for all other microscope slides

• the complete mulitwell plate

The current field of view is indicated with a red blinking rectangle or point. You
can move this red frame by clicking and dragging the left mouse button. The
motorized stage moves automatically to the chosen detail. With this navigation
method you always see the position on the slide.

You can also move to the position of interest by double clicking into the over-
view area with the left mouse button.

Define the area of the scan with the Select area tool. After pressing the button
you can select the area of interest in the overview window using the mouse.
Only the area of interest will be scanned.

Begin the scan by pressing the Start Scan button. You can always interrupt
the scan with the Stop scan button. Also pressing the Esc key will interrupt
the scan.

The scanned image can be made available to other applications. Use the
Save button or the corresponding menu item to save the overview image to
disk. Alternatively select Copy image to clipboard from the popup menu next
to the Save button to copy the overview image into the Windows clipboard and
paste it in other applications.

To erase the scanned image, click on the Clear overview image button.

To move from one slide to another you can directly select the target slide
button. Alternatively you can move to another slide with the keyboard arrow
keys. The slide number indicator will automatically adjust to the current slide.

If slide number indicator does not fit with the position of the stage, please refer
to section 5.5.

5.4.5 Pin positions

With the pin button you can save the current stage position. By clicking on the
arrow to the right you obtain the pin positions menu (Fig. 5.11).

You can select a pin, which moves the stage to the respective position. The
last two entries enable you to delete either the currently selected or all pin
positions.
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Figure 5.11: Pin positions

5.4.6 Inspection position

Objects collected on the cap can be easily viewed when the cap is set down in
an empty location on the slide. For this purpose you can define an inspection
position.

Figure 5.12: Setting the inspection position

To define the inspection position click on the triangle at the right edge of the
inspection button (Fig. 5.12) and select Set inspection position. Click on the
desired location in the slide overview. A cap marker will appear in the slide
overview if Show inspection position is activated.

After the position has been set, you can quickly move between your current
working position and the inspection position by clicking the inspection button.
The cap lift will be lowered automatically.

To delete the cap marker, select Delete Inspection Position from the popup
menu.

5.4.7 Process scan with CellExplorer

To automatically analyse all overview scan tiles with the image analysis soft-
ware mmi CellExplorer check the Process scans with CellExplorer check-
box in the Overview panel.

You need to switch in the mmi CellExplorer panel and define a
parameter set once, before Process scans with CellExplorer will
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work properly, see chapter 8. After switching back to mmi CellCut
the calculated shapes are automatically available.

5.4.8 Shape navigation

In mmi CellCut objects in the sample, like cell areas or cells, are displayed as
shapes. These shapes can be created manually or by using mmi CellExplorer,
see section 5.4.7 and 8.

Once you created shapes you navigate between the shape by using

• move to first shape, Home key

• move to last shape, End key

• move to next shape, + key

• move to previous shape, - key

In mmi CellCut the keyboard keys allways navigate inside the current group,
see section 6.3.4. The shapes can be directly used for cutting.

5.5 Stage geometry and stage viewer

In order to properly navigate through your samples the geometry of the stage
insert must be properly defined. The stage insert is the mechanical holder
of your slides or multi-well-plate, which usually simply snaps into the micro-
scope motorized stage. These definitions are a precondition for the use of the
overview, see section 5.4.4 scan.

The stage viewer Fig. 5.13 can be opened via the menu

Stage→Show insert (Ctrl + I)

or alternatively by the Show stage insert button in the overview panel.

The window has following main purposes:

• configure the geometry of the

– stage insert and

– slides or microplates, each containing the active regions called wells.

• assign a role to each well

• display and zoom the overview images
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Figure 5.13: The stage viewer shows the geometrical configuration of your stage
insert. The position the insert and the slides can be adjusted so that overview
images exactly match the stage configuration.

• navigate through your samples, by double-clicking on the target position

• exporting and importing stage geometries

• calibrate the stage

The stage insert is divided in following regions:

• stage insert

• slides or microplates

• active regions, called wells

By moving the mouse over the stage insert, the current region (the stage insert
itself, a slide or a well) will be highlighted. That region can be selected via a left
mouse click. Selected regions will be displayed with a red border. The editor
button will now open the configuration panel of the selected region. For wells
a multi-selection is possible. The configuration of the regions is explained in
the following sections 5.5.1, 5.5.2 and 5.5.3.

The full geometry configuration can be exported into a file by
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File→Export

Using

File→Import

the configuration can be reloaded into the stage geometry viewer.

5.5.1 Stage inserts

Figure 5.14: Stage viewer: Insert configuration panel. You can select different insert
types and shift the whole insert to adapt it to overview images.

In the configuration panel (Fig. 5.14) different types of slide inserts can be
selected:

• insert for three microscope slides, clamps on the right hand side

• insert for three microscope slides, clamps on the left hand side

• insert for multiwell plates in SBS format

• insert for 88.5 mm petri dish

Second you get the option to shift the whole insert. This feature allows you
to precisely overlay a scanned overview image with the displayed slides. It is
recommended to first shift slide 1 to fit it’s stage insert position. If the overview
image of slide 1 does not exatly fits into the slide shift the insert as described
in chapter 5.5.5.
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Figure 5.15: Stage viewer: Slide configuration panel. You can select different slide
types and shift the whole slide to adapt it to it’s overview image.

5.5.2 Slides

Depending on the stage insert selected in section 5.5.1, the configuration
panel for slides (Fig. 5.15) offers a selection of different slide types. If your
slide type is not listed, you can define and configure a custom slide.

• MMI membrane slide

• MMI membrane slide, mounted roted by 180°

• 8 well MMI service slide

• MMI petri dish

• MMI single cap holder

• Ampligrid

• plain glass slide

Additionally you shift the slide. This feature allows you to precisely overlay a
scanned overview image with the displayed slide. By the slide shifting proce-
dure you can correct the geometry of your stage insert to precisely reflect the
hardware.

If overview scan in slide 1 match the slide configuration, it is recom-
mended only to shift slide 2 and 3. It is acceptable that slide 2 and
slide 3 do not perfectly match the displayed stage insert positions.
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If overview scans in slide 1 are shifted against the geomtetry dis-
played, first calibrate the stage origin, see section 5.5.4. If this is
not sufficient follow the procedure described in section 5.5.5

5.5.3 Active regions, wells

Figure 5.16: Stage viewer: Well configuration panel. You can select different well
rules and add descriptions to each well.

In the well configuration panel you can define follwing rules for each well:

• region for microdissection

• collection well for CellEctor

• deposit well for CellEctor

• rinse well for CellEctor

• unused well

Currently thess rules are exclusively used by mmi CellEctor. Additionally you
can add own descriptions to each well.

5.5.4 Stage calibration

Under normal circumstances, the stage calibration remains valid unless the
stage is moved manually or using a software other than mmi CellTools.

If the software detects an invalid stage calibration, slide scanning will be dis-
abled and the overview scan will show a red warning sign.

In this case or if the overview scans are shifted against a correct stage geom-
etry stage recalibration is required.

46



MMI CellCut Plus

To recalibrate the stage start the calibration procedure by on of the following
options:

• press the Calibrate origin button in the stage viewer.

• Stage→Calibrate origin (Ctrl + O) in the main CellTools window.

During the calibration process the microscope objective will move down and
the stage will move to its limit switches. If the stage geometry is still not match-
ing a scanned overview image, the stage geometry configuration needs to be
adjusted, see sections 5.5.2 and 5.5.5.

5.5.5 Stage geometry first configuration

To adapt the insert position to scanned overview images proceed as follows:

Procedure

1. select the mounted insert in the insert configuration panel

2. select the mounted slides in the slide configuration panel

3. shift the first slide to it’s position in the stage insert, see section 5.5.2

4. calibratre the stage origion, see section 5.5.4

5. scan an overview image in slide 1, see 5.4.4 and adjust the image to the
slide position by shifting the whole insert. To get a precise positioning we
recomment to adjust the image of the left upper corner of an membrane
slide (Fig. 5.17) or the image of wells of an ampligrid to the displayed
slide.

6. press OK

7. adjust the other slides to their overview images, see section 5.5.2

This procedure only has to executed for a new stage insert. If the configuration
is properly set, a mismatch between the scanned image positions and the slide
configruations indicates a corrupt stage origin calibration. Recalibration of the
stage origin, see section 5.5.2, will be sufficient.

You are now ready to use slide navigation and scanning. The field-of-view
indicator and the dimensions of the slide overview will adapt during calibration.
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Figure 5.17: Suggested positions on a mmi Membrane slide to precisely adjust the
stage insert position
.

Figure 5.18: Distance measurement

5.6 Distance measurement

Select the measurement tool to measure distances on the sample.

Press the left mouse button and drag the mouse. After releasing the mouse
button you can see the measured distance (Fig. 5.18)

5.7 Calibration

5.7.1 Camera alignment

For the software to correctly overlay objects onto the camera image, and to
correctly measure distances, the exact width and height of the field of view in
millimeters must be known for each objective and optical setup. mmi CellTools
offers a fully automated calibration procedure that makes it easy to measure
these dimensions. The procedure also allows to minimize positioning errors
due to a tilted camera mount.

Camera alignment must be carried out independently for each
objective, as each objective has a differently sized field of
view.
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To prepare automatic alignment, place an arbitrary sample on the microscope,
navigate to an area that yields an image of good contrast and focus. A slide
with printed text on its surface is also suitable as long as it can be optimally
focussed. Start alignment by selecting

Stage→Align camera

from the main menu.

Figure 5.19: Camera alignment results

If automatic alignment was successful, a dialog (see figure 5.19) displays the
results, which include:

• The measured width and height of the field of view,

• The relative standard error of the measured width and height, and

• The measured inclination of the camera.

Ideally, camera inclination should be very close to zero (< 0.3◦). If it is larger,
eliminate camera tilt before proceeding (see section 5.7.1.1). The lower the
standard error of width and height, the more accurate positioning can be
achieved. The standard errors can be reduced through optimal focussing and
by viewing an area of high contrast at optimal illumination. (Also ensure that
microscope illumination is set up correctly.)

If satisfied with the results, click Accept to use the measured values. In some
cases, the automatic procedure does not yield an acceptable result and dis-
plays a failure message. In this case you may adjust lighting, view a different
area on the sample and retry.

When finished, check that the stage exactly follows mouse movement when
using the Move stage tool. Also verify that any shapes that you draw match
the objects as close as possible after you move the stage. If not, repeat the
procedure.

When working with a motorized microscope, mmi CellTools will ask whether
you would like to use the results for all objective items at this nosepiece posi-
tion. If you choose yes, the measured values will be used in all other setups
as well (see section 5.2).
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5.7.1.1 Eliminating camera tilt

If the camera was unmounted or accidentally pushed out of its position, the
following procedure will help restoring the upright mounting position.

Procedure

1. Start automatic stage alignment as described above

2. If camera inclination is larger than 0.3◦, slightly loosen the camera’s
mounting screw using the supplied hex wrench, turn the camera by a
very small amount and retighten screw (lightly).

3. Repeat alignment until inclination is optimal

4. Fully tighten mounting screw.

5.7.2 Lens offset calibration

Because of mechanical and optical tolerances two objectives never have ex-
actly the same optical axis. You see this effect by observing pixel shifts in the
video when you change an objective. The Set lens offset (paraxial) function
is introduced to search and draw your dissectates in one objective and cut with
a second objective.

When you install a new objective into your microscope you have to calibrate
the Lens Offset. Over the time of operation it may be necessary to recalibrate,
when contours and cutting lines are no longer exactly fitting.

Procedure

1. Please note the Lens offset calibration procedure should go from the
objective with highest magnification to the objective with the smallest
magnification. The standard order is:

(a) 40x to 20x

(b) 20x to 10x

(c) 10x to 4x

If your system is set up with other magnifications please select the order
of calibrations in the same manner.

2. Verify that the camera is aligned with the stage (movement follows mouse)
and mounted in an exactly upright position.

3. Mount a slide with a sample.
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4. Select the start (higher magnification) objective and the corresponding
objective in the software

5. Move an easily noticeable object to the centre of the video screen.

6. Start the Lens Offset calibration procedure with the menu item

CellCut→Objective→Lens Offset (paraxial)

7. Draw a line around that object

8. Change the objective at the microscope and in the software

9. Move the shape exactly over the selected object

10. Complete the calibration with a right mouse click.

You are now asked whether you would like to calibrate further objectives. If
you answer “yes” you are asked to repeat steps 8 and 9 for another objective.

Ensure that the shape is sufficiently large to start with. If at any point dur-
ing the calibration, the shape becomes too small to be moved accurately, you
may simply delete the shape and proceed with a new, larger shape. Alter-
natively, you may stop the calibration procedure at a mid-range objective and
later restart the calibration procedure, starting from that objective downwards.

You can cancel the calibration procedure with the Esc key.

5.8 Multi-user report

Users can get information about time spent using mmi CellTools for each Win-
dows user account.

Figure 5.20: Multi-user report

Select the menu item
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Project→Usage report

or start it from

Start→All Programs→mmi CellTools→mmi MultiUser Report

A time format is hhhh:mm:ss.

5.9 Help

5.9.1 Help topics

The user manual can be opened directly inside the mmi CellTools software.
By pressing F1 on the keyboard the PDF file of the User Manual shows up.
You also launch the user manual by selecting the respective item in the Help
menu.

5.9.2 MMI online

If your PC is connected to the internet you can launch the MMI web page by
the menu item

Help→MMI online

Questions about the system can be sent to MMI service staff by the item

Help→Online Support

5.9.3 Version info

Information about the currently installed software version can be found under

Help→Version info
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6 mmi CellTools – CellCut plug-in

As described in section 5.1, the special features of the mmi CellCut, the mmi
CellExplorer and mmi CellManipulator are installed as separate plug-ins (soft-
ware modules). The mmi CellCut plug-in appears as a separate tool panel on
the right side of the program window.

To switch from one plug-in to the other you only have to click on the appropriate
tool panel (Fig. 6.1).

6.1 Drawing the cutting contour

6.1.1 Basics

You can draw using the mouse on the video panel. If your system is set up
with an interactive pen display you can draw directly on the screen using the
pen.

The laser cuts along the contour which you have drawn around the interesting
area you want to microdissect. The following calibration and settings need to
be done correctly before you can start cutting:

1. Camera alignment, section 5.7.1

2. Cutting velocity, section 6.2.3.1

3. Laser focus, section 6.2.3.2

4. Laser power, section 6.2.3.3

5. Laser position, section 6.7.1

After drawing the contours of the shapes press the cut button and all defined
contours will be cut.
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Figure 6.1: The CellCut plug-in panel
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Figure 6.2: Defining contours to cut

6.1.2 Drawing tools

The drawing tools can be switched using the buttons in the tools panel

freehand
shape

select or
move

circle ellipse line rectangle

move
stage

erase measure

Figure 6.3: Drawing tools

The drawing mode can be activated through the buttons in the mmi CellCut
plug-in or in the context menu (Fig. 6.4). The context menu can be activated
by pressing the right mouse button (with the cursor in the video window) and
by choosing Draw/edit shape. The last used drawing tool will be activated.

A quick switch between moving and drawing mode is possible by pressing the
Space key on the keyboard.

6.1.2.1 Select and move shapes

With the select or move tool you can select and activate single contours with
a left mouse click. To adjust the positions of individual shapes, click and drag
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Figure 6.4: CellCut context menu

on a shape.

To adjust the positions of all shapes (e.g. to compensate for a shifted sample)
use the move stage tool (section 5.4) while holding down the ALT key.

6.1.2.2 Freehand

The freehand drawing tool allows you to define arbitrary shapes. Use the left
mouse button to draw the contour around the area of interest.

Figure 6.5: Freehand drawing options

CellTools normally closes the contour automatically when you release the left
mouse button. If this is not desired, you can turn it off by unchecking the tick
box “Closed shape”.

Some objects, especially those larger than the field of view, cannot be traced
with a single drawing operation. For such cases multiple segments can be
combined into a single shape.

Procedure

1. Start outlining the object normally using the freehand tool as far as the
field of view allows.

2. Move the stage such that the end of the drawing is still visible and you
can continue drawing.

3. While holding down the SHIFT key, draw the second segment. (You may
release the key while drawing.) Once you have finished drawing, the two
segments will be attached.

56



MMI CellCut Plus

4. Repeat steps 2–3 as necessary.

As an alternative, you can check the tick box “Extend selected shape (multi-
segment drawing)” instead of holding the SHIFT key. Remember to uncheck
it when you have finished with the last segment.

Multi-segment drawings may be easier to do when “Closed shape” is off (un-
checked).

6.1.2.3 Circles

The circle tool is suitable for creating circular shapes.

Figure 6.6: Circle tool

Fixed-size circles can be created by checking “Fixed diameter” and typing the
value in the corresponding input box (Fig. 6.6).

6.1.2.4 Ellipses

Certain shapes can be approximated as an ellipse. Drawing an ellipse is done
in two steps:

• define the major axis (longest distance)

• define the minor axis (width)

Figure 6.7: Ellipse tool
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Fixed-size ellipses can be created by checking “Fixed geometry” and typing
the values in the corresponding input box (Fig. 6.7)

6.1.2.5 Lines

Cutting straight lines may be useful for ablation or cell-surgery type experi-
ments, as well as for cutting tests.

Figure 6.8: Line tool

Fixed lines can be created by checking “Fixed length” and typing length and
angle in the input boxes. To reverse the cutting direction, enter an angle of
180◦.

6.1.2.6 Rectangles

Rectangles provide a quick method to outline objects of interest. Combined
with the area ablation option (section 6.4) they are useful for ablation type
experiments.

Figure 6.9: Rectangle tool

Fixed-size rectangles can be created by checking “Fixed dimensions” and typ-
ing the values in the corresponding input box (Fig. 6.9).

6.1.2.7 Deleting shapes

There are several ways to remove shapes:
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• Deleting arbitrary shapes using the eraser tool

• Deleting the current (highlighted) shape by pressing Del

• Using the context menu (Fig. 6.4)

• Using the group statistics window (section 6.3.6).

To delete all shapes, or all shapes from the current group, use the context
menu (Fig. 6.4) or corresponding keyboard shortcuts Ctrl + Del and Ctrl +
Shift + Del .

6.1.2.8 Copying and pasting shapes

To copy the active contour use the menu item

Edit→Copy shape

Select

Edit→Insert shape

to insert the copied shape.

The corresponding keyboard shortcuts are Ctrl + C for Copy and Ctrl + V for
Paste.

6.1.2.9 Cloning

Cloning is a more controlled way of replicating shapes. This function is espe-
cially useful for laser ablation experiments, or when you need to collect multiple
pieces of tissue at regular distances. The clone function allows you to create
multiple copies of a shape, where copies are arranged in a rectangular grid.

To start, select the shape you would like to clone and select

Edit→Clone...

or use Clone... from the context menu (Fig. 6.4).

The dialog allows you to specify the number of shapes per row and per col-
umn, as well as the distances between rows and columns. Depending on your
application, you may choose whether distances are measured between the
shapes’ edges or from center to center.

Click the Preview button to see the result, or click Ok to generate the clones.
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Figure 6.10: Clone shapes

Note that, on systems with an automated microscope, the system
will focus on each cloned shape using the sample plane focus
mechanism (section 7.4.2), if enabled. If clones are out of focus
when cutting, either redo the sample plane definition or disable
plane tilt focussing.

6.1.2.10 Navigating between shapes

There are several keyboard commands that allow you to locate your shapes
and navigate between them. These are illustrated in Fig. 6.11.

Insert Home Page
Up

Page
Down

Del End

0

1 2 3

4 5 6

7 8 9

.

Num
Lock

/ * -

+

Enter

move to 
previous shape

move to 
next shape

move to 
first shape

move to 
last shape

delete 
shape

press: minor steps
hold: slow movement

press: major steps
hold: fast movement

Figure 6.11: Keyboard navigation
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6.2 Cutting dissectates

6.2.1 Single laser shot

The laser shot button is used to activate the laser for a short time period, or to
generate a single laser pulse (available on CellCut II systems only).

The time duration can be adjusted from the drop-down menu next to the button
(Fig. 6.12). The default setting of the single laser shot time is 50 ms. A range
of 50–100 ms is typical.

Figure 6.12: Single shot laser settings

CellCut II systems can be configured to produce a single laser shot instead
of timed activation. This will achieve the shortest possible laser activity and
therefore applies the minimal achievable energy to the sample. To change the
default mode, activate the checkbox Single pulse.

Both laser shot modes can be triggered independently of the above setting
using the commands in menu CellCut →Laser or via the keyboard shortcuts
Ctrl + M (timed interval) and Ctrl + Shift + M (single pulse).

6.2.2 Overview

The automated cutting along the contours makes your work easy and fast. You
can decide if you want to cut one area or a group of areas.

For most applications the best cutting results are observed with the 20x or the
40x objective. The user must select the appropriate objective in the objective
selection box (Fig. 6.13).

Figure 6.13: Objective chooser

The laser setup includes the following parameters (Fig. 6.14).

• Cut velocity (of stage movement)
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• Laser focus

• Laser power

Figure 6.14: Dissection panel with laser parameters

It is essential for optimal cutting performance to properly adjust these param-
eters for each objective and tissue type.

6.2.3 Dissection parameters

6.2.3.1 Cutting velocity

The velocity slider defines how fast the stage moves during the cutting pro-
cedure itself (unit: µm per second). It does not affect any other movement
parameters of the stage.

6.2.3.2 Laser focus

The focus slider adjusts the focus position of the laser beam in the z-direction
within the tissue sample. The cutting performance is very sensitive to this
parameter. For example, the user would expect to use different focus settings
for soft tissue vs. bone.

Focus position is normally given in µm or mm units. Note that the range of
the focus depends on the current objective. Also, the displayed value cannot
be taken as an absolute distance – the 0 mm position simply denotes that the
laser focus position is as close to the objective as possible for the objective.
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If your system displays percentages instead of metric values, ensure that the
magnification values for the objectives are set (see section 5.2.3).

6.2.3.3 Laser power

The power slider defines the laser power. The power needed to cut the sam-
ple normally will be proportional to the sample thickness. Choose the power
setting which enables clean laser cutting.

Depending on your system configuration, power is given as a percentage, or
in milliwatts (mW).

If available, the milliwatt value refers to the average laser output power before
passing through the optical componentes inside the mmi CellCut optics and
the microscope. Typical microscope objectives for fluorescence applications
have UV transmissions between 80% and 95%. Note that the milliwatt power
value value is based on measurements performed at the MMI factory site. The
actual laser power is not monitored in the device.

6.2.3.4 Iterative dissection

Iterative dissection can be used for tissue that is difficult to cut, e.g. very hard
or thick tissue.

Figure 6.15: Iterative dissection user interface. Z drill is only available on systems
with an automated microscope

The Repeat field indicates the number of times that the laser should process
each shape. Increase if a single iteration does not completely cut through the
tissue.

Before increasing the Repeat count, make sure you laser parame-
ters are optimal (see section 6.2.5).

The z-drill option (only available with motorized microscopes) can be used in
conjuction with the Repeat field. After each iteration, the microscope’s focus
drive is moved down by this amount, effectively drilling through the tissue from
top to bottom.
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6.2.3.5 Options

Viewing or hiding dissected shapes By default, shapes that have been processed,
are drawn with thin, dashed lines for quality control. In some application this
may be distracting. To turn off display of dissected shapes, check the Hide
dissected shapes option.

Focussing delay Some thick or uneven samples may require manual focussing
prior to dissection. Therefore it can be convenient to allow some time for
focussing before the laser is switched on and dissection starts.

This option is turned on by checking the Focussing delay option. Enter the
number of seconds to wait in the entry field that appears next to the check box.

6.2.4 Cutting tests

Before dissecting the tissue of interest, test the laser performance in another
area of the sample or on a test slide with the same tissue. Draw a line or a
circle and start cutting this figure with a low speed. Change the focus and
power parameters during cutting to observe the effects. The sharpest cutting
line is obtained with power as low as possible and with exact focus.

Fig. 6.16 shows a typical example of a cut.

Figure 6.16: A cutting test on a piece of biological tissue
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6.2.5 Adjustment procedure

To adjust the parameters start with a high power value. The focus can be
adjusted easier with high power. Make several cuts with different focus values
and compare the results. With a reduced power the focus will be in a more
defined area. Decrease the power step by step and repeat focusing until the
cutting line is continuous, fine and clear.

You can store as many of the laser parameter settings as necessary for each
objective. To define new settings see section 5.2.

6.2.6 Laser safety

When the laser is turned on a small window with a laser warning label always
pops up (Fig. 6.17). When the software turns off the laser, the symbol disap-
pears.

Figure 6.17: Laser safety warning sign

6.2.7 Hiding the laser position icon

By deselecting the menu item

CellCut→Laser→Show laser position

the laser position icon can be hidden. After selecting the item again the laser
position icon becomes visible again.

6.2.8 Focus memory

On systems with an automated microscope, mmi CellTools automatically
saves the current position of the microscope’s focus control with each shape
that you draw. Before cutting, that focus position is restored.

For focus memory to work correctly, microscope remote control must be
switched on (see section 7).
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6.3 Single-step collection using the mmi IsolationCap

The mmi IsolationCap is a standard Eppendorf™ tube with a special adhesive
material filling the cap. By lowering the cap onto the membrane a contact will
be established. If you lift the cap after cutting, the dissectate will be fixed to
the cap by adhesive force.

6.3.1 Available IsolationCap consumables

The mmi IsolationCaps are available in the following sizes

• 200 µl

• 500 µl

• 1500 µl

• strips of 8 caps for 200 µl tubes

The standard mmi IsolationCap for a single step collection contains a diffuser
inside the adhesive material of the cap. If you position the cap over the area
of interest you will receive the maximum image quality during microdissection
operations.

You can also order transparent caps. The adhesive in the cap does not contain
a diffuser material and is suited to fluorescence applications.

6.3.2 mmi CapLift

6.3.2.1 Versions

The mmi CapLift system is available in two versions. The standard version
gives you the option to automatically lower and lift a single cap. The standard
CapLift system is able to hold a 500 µl cap.

The mmi MultiCap version of the mmi CapLift can additionally handle eight-
cap strips. With this option you can auto sample eight different types of dis-
sectates. The mmi Multi Cap is described in section 6.3.7.

In some life cell applications where you need more workspace on top of the
stage and where you don’t need the mmi CapLift, you can easily unplug the
complete mechanism.
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6.3.2.2 Mounting cap

To mount the tube, simply move the closed tube into the cap holder and then
open it. The tube holder can easily be fixed to the automatic cap lift. The lift
has an easy to use auto positioning system. Bring the cap in front of the lift,
and slide the cap holder towards the holder counterpart. The holder will be
fixed automatically by a small magnet.

6.3.2.3 Adjusting cap pressure on membrane

The cap pressure on the membrane can be changed by a knurled screw on the
left side of the mmi CapLift mechanism. If you use thin cover slips instead of
1mm glass slides the correct cap pressure allows extraction of the dissectates
without adversely bending the cover glass.

6.3.3 Cap lift settings

You can cut an object with the mmi CapLift in top (up) and bottom (down)
position. But the mmi IsolationCap works most reliably if microdissection is
done in the cap down position.

The stage can also be moved when the cap is down. The maximum moveable
distance, without lifting the cap, will be limited to avoid tearing or other damage
to the sample membrane.

A sophisticated software algorithm, the mmi “Predefined Target Positioning”
(PTP) function, optimizes the use of the mmi IsolationCap when many dissec-
tates are sampled over a large slide area.

The software automatically identifies when there is no more usable area on
the cap. A message will pop up, requesting the user to mount a new cap in
the cap holder.

6.3.3.1 Basic settings

For standard applications the standard settings should be used and not
changed. Only the cap type in use must be selected.

The options are displayed in the PTP section of the CellCut panel (Fig. 6.18).

If you use an eight-cap strip, select the 200 µl option.

If the cap is down on the tissue the cap will automatically be lifted whenever
you leave the collection distance area by moving the stage. The cap will be
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Manual cap lift
operation

Dissect with
raised cap

Dissect with
lowered cap

(recommended)

Collect multiple 
shapes (clustering)

Collect one
by one

(no clustering)

Figure 6.18: Predefined target positioning (PTP) panel

repositioned automatically.

You can choose between three dissection modes using the buttons:

• Manual mode means that you have to operate the cap lift yourself, PTP
is switched off.

• In Dissect with lowered cap mode the dissectates are cut with the cap
in the lower position and will be collected automatically. This mode is
recommended for most applications.

• In Dissect with raised cap mode the dissectates are cut with the cap in
the upper position and will be collected automatically.

If you check the New Cap for each dissection tick box the system assumes
that you use a new cap each time you press the Cut button. This will affect the
placement of dissectates on the cap’s adhesive surface. If you use one cap
for more than one cutting procedure deselect the check box and either use the
menu item

CellCut→Cap Lift→New Cap

or press the New cap button each time you change the cap in the cap holder.

Two clustering modes are available using the lower left buttons in the PTP-
area (see Fig. 6.18). The default behavior is to simultaneously pick up multiple
objects whenever possible (clustering). Alternatively you can decide to pick
the dissected objects one by one (no clustering). The latter will be slower, but
produce more accurate placement on the cap’s adhesive surface.
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6.3.3.2 Advanced settings

To be able to optimize the mmi CapLift functionality several advanced set-
tings can be adjusted by the user. These settings are only suggested for
experienced users and can be selected by the Change settings. . . button
(Fig. 6.19).

Figure 6.19: Adjusting PTP cap parameters (advanced)

Usable diameter The usable diameter depends on the mmi CapLift version
installed on your system and the diameter of the mmi IsolationCap.

For older mmi CapLift systems (cable connected to the mmi CellCut con-
troller box) the diameter is limited to 2000 µm.

For new versions of mmi CapLift (cable connected directly to the PC) the
maximum diameter is 6000 µm. The usable diameter must be restricted
only for the small cap sizes.

If the cap lift is down you can only cut objects fitting into the usable
diameter area. If you work with a 500 µl cap it is recommended to set a
diameter of about 4200 µm.

Deposition grid size Default value for the grid size is 1.

If you want to dissect clusters of single dissectates the mmi Predefined
Target Positing (PTP) algorithm must be tuned by setting the grid size
to the average size of the clusters. The average size is measured in
multiples of the average dissectate size.

As an example if the normal cluster size is about 10 times the size of the
dissectates, set the grid size to 10.

Clustering distance The clustering distance describes the maximum dis-
tance the stage can move after lowering the cap.
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The standard setting for the clustering distance is between 1000 µm and
2000 µm. The clustering distance always has to be smaller than the
usable radius.

If you set the clustering distance to values smaller than the normal dis-
sectate size then the cap will be lifted before each cut of the dissectates.

If you set the clustering distance equal to the usable diameter then all
dissectates inside this radius will be cut and collected. The user gets the
message that the cap is filled up.

The smaller the clustering distance the more frequently the cap will be
lifted.

6.3.4 Group Handling

Any object drawn will always be assigned to the current group shown in the
group selection box (Fig. 6.20).

Figure 6.20: Group selection

The most common application for using more than one group is to collect dif-
ferent types of cells on different mmi IsolationCaps (e.g. Group A with Cap A,
Group B with Cap B, etc. or using the mmi MultiCap).

All objects of the same group are marked with the same contour color. The
number of groups is not limited.

To switch between groups, select the group of interest from the group list. If
the mmi MultiCap is installed and active, it will immediately turn such that the
selected cap is in position.

6.3.4.1 Definition and editing of groups

In order to deal with groups invoke the Group editor (Fig. 6.21) using the edit
button next to the group selection box.

To define a new group press the Add button. To delete the selected group
press the Remove button.

You can adjust the group name and drawing attributes (color and line thick-
ness) in the lower part of the editor. The cap number can only be set if the
mmi MultiCap is installed and activated (see section 6.3.7)
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Figure 6.21: Group editor

6.3.4.2 Regrouping shapes

To move individual shapes from one group to another, open the context menu
(Fig. 6.4) by right-clicking on the drawing area and select the target group from
sub-menu Move into group.

6.3.5 Group statistics

The statistics page is located in the lower right panel (Fig. 6.22).

Figure 6.22: Group overview

This page shows a list of all defined groups. For each group the list displays
the total shape area (sum of the areas of all shapes), the number of shapes
and whether the shapes are already cut. With the checkbox in the last column
you can specify whether the group will be cut again. By default the shapes
drawn since the last cutting operation will be cut again; see the next section
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how to change this.

To export the entire data sheet to a file, click Export. Data is saved as
character-separated values (CSV) file, which can be opened by most data
visualization and spread-sheet programs.

6.3.6 Shape list

If you click on a group name in the group statistics page, a list with all shapes
defined in that group pops up (Fig. 6.23).

Figure 6.23: Shape list

The list displays the area of each shape and a tick mark for the cut shapes. By
clicking the Cut again checkbox each shape can be cut again.

To quickly deselect or select all shapes, use the checkbox at the bottom.

By a double click with the left mouse button on the area field in the shape list
the stage is navigated to the selected shape.

The selected shape can be deleted by pressing the keyboard Del key.

To export the entire data sheet to a file, click Export. Data is saved as
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character-separated values (CSV) file, which can be opened by most data
visualization and spread-sheet programs.

6.3.7 Cutting with mmi MultiCap

If the mmi MultiCap system is installed, the group name will always start with
the word “Cap” followed by the number of the corresponding cap (Fig. 6.24a).

(a) MultiCap operation (b) single cap operation

Figure 6.24: MultiCap vs. single cap mode

If the mmi MultiCap is not installed or the single cap mode is selected, the
group name will always start with the word “Single:” (Fig. 6.24b).

To switch from a single cap holder to MultiCap holder select the menu item

CellCut→Cap Lift→Single Cap

or

CellCut→Cap Lift→Multi Cap

6.3.7.1 Using mmi MultiCap

Users can cut one, several or all of the shape groups in one single step.

Click on the arrow to the right of the Cut button and select the desired group
or groups.

After selection of the groups, press the Cut button to initiate the cutting pro-
cess. Automatically the mmi MultiCap selects the corresponding cap and
starts cutting of all dissectates in the active group. After finalizing the active
group, the next selected group and the corresponding cap will be selected and
cut. If a single cap holder is installed all shapes from all groups will be cut as
if they were in one group.

The maximum number of separate caps using the mmi MultiCap is 8. By
creating a new group the next available free cap is assigned to that group.
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Figure 6.25: Cutting multiple groups in one operation

6.3.7.2 Calibration

The mmi MultiCap system can be calibrated if the caps are not aligned in the
light path correctly. Mainly this happens if the motor axes are turned acciden-
tally when changing the cap holder. Calibrate the mmi MultiCap by selecting
the menu item

CellCut→Cap Lift→Calibrate Multi Cap lift

In some cases it is necessary to adjust the cap holder after calibration. Select
the menu item

CellCut→Cap Lift→Cap lift adjustment

turn left turn right

Figure 6.26: Cap lift adjustment

After adjustment recalibrate the cap holder.
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6.4 Area ablation

mmi CellTools includes the ability to ablate the area of arbitrarily shaped ob-
jects.

Figure 6.27: Area ablation panel

Area ablation is activated through the check box in the Area ablation panel
(Fig. 6.27). When checked, the laser will not trace the contour, but instead
follow a meandering path, covering the shape’s entire area.

Depending on the object’s shape CellTools may not be able to find
a single consecutive path that covers the entire area. In this case,
the operation is automatically split into multiple paths which are
then cut one after the other.

For optimal results, adjust the Line spacing parameter to eliminate gaps be-
tween cutting lines. This value should be equal to the width of the cutting
line.

Open free-hand drawings and shapes create using the Line tool and are not
affected by the ablation option.

6.5 Serial sections

The serial sections functions permits dissection of the same objects on more
than one slide. Objects can be marked on a master slide and subsequently
copied to one or more section slides. In order to locate the objects on the
section slides, you provide a set of reference points (at least one and up to
three).

The serial sections function allows you to dissect samples without dye. In
this case, the staining procedure is only applied to the master slide in order
to identify objects, and not to the remaining sections. This is useful in cases
where the dye may create artifacts in the sample.

6.5.1 Mode of operation

CellTools uses geometric transformations to map object positions and shapes.
Reference points are used to define these transformations. For most applica-
tions, using at least two reference points is recommended. These should be
clearly visible points in your section that are easy to locate precisely.

75



6. MMI CELLTOOLS – CELLCUT PLUG-IN

Depending on the number of reference points used, CellTools will apply dif-
ferent types of changes to the objects’ original shape and thus accommodate
variations in shape that were introduced in the sample preparation process.

Table 6.1: Transformation types with 1, 2 and 3 reference points

Reference
points

Types of transformation Transformation preserves

1 Translation size, orientation and angles

2 Translation, rotation and
scaling

angles

3 Translation, rotation, scaling
and shearing

neither of the above

Depending on the process used, you should decide on the number of refer-
ence points that works best for your application. For example, when samples
may have been subjected to shearing during slide preparation, it is imperative
to have three reference points per section. If you can ensure that a 90◦ angle
on one slide will remain rectangular on another (that is, no shearing occurred),
two reference points are sufficient.

6.5.2 Basic usage

active section
(with number of 

shapes in brackets)
sections 

editor

set reference
point tool

transfer shapes from
master to active section

Figure 6.28: Serial sections panel

Procedure

1. Insert the master slide. Mark objects as usual.

If desired, objects on the master slide can be cut, too. To do so, click on
the Cut button as usual.
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2. In the Cellcut panel, open the serial sections panel. The serial sections
panel shows the currently active section, tools to mark reference points
and the transfer button.

3. Select the Set reference point tool to mark the locations of your refer-
ence points. Define between one and three reference points.

4. Remove the master slide and insert the first section slide.

If your section is located on the same slide, ignore this step.

5. Open the serial sections editor (Fig. 6.29) by clicking on the button to the
right of the active section display. Add a new section by clicking on the
Add button. Close the editor. Your newly created section is now active
and your marked objects are no longer visible.

Figure 6.29: Managing sections

6. Locate the reference points on the section slide, again using the Set
reference point tool.

Reference points points must be entered in the same order on
each section.

7. When finished, click the Transfer button to transfer the objects from mas-
ter slide to the active section.

8. If satisfied, use the Cut button to start dissection as usual.

You can refine the transformation by moving reference points and clicking
on Transfer again.

9. Repeat steps 4–8 for subsequent sections.

At any time you can switch forth and back between the master slide and the
defined sections using the drop-down list in the serial sections view. Do not
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forget to switch back to the master slide to commence work on a different
sample.

Once the reference points are defined, you can move a particular reference
point into view by clicking on the arrow to the right of the Set reference point
tool. A pop-up menu will appear, listing all available reference points for the
currently selected section (Fig. 6.30). Clicking on one of the menu items will
move the stage so that the reference point is centered in view.

Figure 6.30: Locating reference points

Reference points can be moved and deleted in the same way as other shapes.

6.5.3 Using shapes to define reference points

Instead of marking reference points directly by clicking, you can use the outline
of a shape to define reference points. If you use landmarks that are rather
large or of irregular shape, this is the preferred method.

Procedure

1. Outline your landmark shape using the regular drawing tools, such as
the freehand tool. Alternatively, select an already existing object using
the select tool.

2. Click on the arrow to the right of the reference point tool and select Cre-
ate reference point from shape from the popup menu. The reference
mark now appears inside the shape, indicating that the shape is now
used as a reference point.

As above, take care to follow the same order of reference points on each slide.

6.5.4 Using multiple-slide trays

The multiple-slide tray allows you to insert the master slide and one or two sec-
tion slides at the same time. If you are working with more than three sections,
you can exchange slides when needed.
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Procedure

1. On the master slide, mark reference points and objects as detailed above
in steps 1–3.

2. Switch on the next slide using the controls in the overview panel.

3. Mark reference points and transfer the objects from the master slide as
detailed above in steps 5–7.

4. If desired, press the cut button, or first proceed to transfer shapes to
another slide.

To cut multiple sections, select the first section to cut in the drop-down
menu ("active section") and press the cut button. When finished, switch
to the next section and press the cut button again. The stage will auto-
matically move to the correct slide.

6.5.5 Using multiple groups

The serial sections function works seamlessly with the multiple groups and the
mmi MultiCap features. Just like on individual slides, you can sort your objects
into separate groups (e.g. according to cell type) and process them separately
in each section (see section 6.3.4.

Procedure

1. On the master slide, mark objects in different groups.

You may need to switch back to the groups view to do so.

2. Switch to the serial sections view and define reference points and sec-
tions as detailed in section 6.5.2.

3. When you click Transfer, all of your groups will get transferred to the
active section.

4. You can cut combinations of groups as described in chapter 6.3.7.1.

Alternatively you can switch groups using the drop-down list in the
groups view, or by clicking on an object within the desired group. Af-
ter that, a single left click on the Cut button will process only that group.

6.5.6 Using mmi CellExplorer to identify shapes

mmi CellExplorer can be used together with serial sections in a straightforward
manner. CellExplorer can be used to identify objects on your master slide.
You can then transfer these objects to subsequent sections by just adding
reference points. Use the procedure described in section 6.5.2.
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6.6 Auto documentation

The auto documentation feature produces a report for each dissection oper-
ation, documenting your experiments with statistical information and images.
The documents include all relevant parameters, main features of the cut dis-
sectates and images of all cutting processes.

The report is saved in html format. It is viewable with a standard web browser
or can be imported with word processing tools. All images are saved as sep-
arate files.

Figure 6.31: Auto documentation

6.6.1 File and folder structure

mmi CellTools automatically organizes reports in a dedicated folder in your
user documents directory. A separate folder is created for each dissection
operation.

To open the autodoc folder select

CellCut→Auto documentation→Browse autodoc folder

or click the folder symbol in the Auto documentation panel. To view the most
recent report in a web browser, select

Cellcut→Auto documentation→Show last report

or click on the View button.

6.6.2 Settings

The settings are displayed in the Auto-documentation section of the CellCut
panel (Fig. 6.31). You can activate auto documentation by checking the Acti-
vate tick box.

By default, images are saved in JPEG format (compressed). If you wish to
save images in a lossless format, choose either PNG or TIFF in the Image
format drop-down.
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Depending on your browser and operating system, TIFF images
may not be displayed correctly in the report. If you experience
problems, you may use the PNG format instead.

If Image before dissection is selected the program saves an image before
each cut. If Image after dissection is selected the program saves an image
after each cut.

6.7 Calibration routines

6.7.1 Laser position

Precise cutting requires that the laser beam position is exactly marked on the
viewing screen. Over time and due to vibration, temperature extremes in the
laboratory environment or accidental moving of the instrument, recalibration of
the laser position may be required.

If the cutting no longer follows the marked line you should adjust the laser
position. This should be done for each magnification separately.

Correct camera alignment is a prerequisite for accurate contour
tracing. In addition, please test whether mouse and stage move-
ment match, and carry out the camera alignment procedure if needed
(see section 5.7.1).

Procedure

1. Locate an empty area on a membrane slide and focus on the membrane

2. Cut a hole in the sample by clicking the Single shot button (see sec-
tion 6.2.1).

3. Select the menu item Cellcut→Laser→Set Laser Position.

4. Locate the center of the hole with the mouse pointer and confirm with a
right mouse button click.

This procedure must be carried out for every objective that will be used for
dissection.
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7 Automated microscope control

mmi CellTools supports the following automated microscope types:

• Olympus IX-81

• Olympus IX-83

• Nikon Eclipse Ti

• Nikon TE2000 E

The automated microscope control functionality must be installed by an autho-
rized MMI technician.

7.1 Activating microscope control

To enable automated microscope control, the microscope’s controller hub must
be connected to the PC (COM port, USB or IEEE1394 FireWire).

The Olympus IX-83 must not be connected to the same FireWire
interface as is used for the mmi CellCamera. When reconnect-
ing cables, observe the labels next to the computer’s interface
plugs, otherwise camera and/or microscope may cease to op-
erate correctly.

To make mmi CellTools connect to the microscope, activate the menu item

Microscope→Remote control

This activates control of objectives, filter block, condenser cassette, fluores-
cence shutter and lamp brightness. The focus knobs on the microscope body
will still be useable.

mmi CellTools will remember these settings and restore them at startup. Make
sure the microscope is connected and switched on before starting mmi Cell-
Tools.
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Table 7.1: Optical path settings for Olympus and Nikon microscopes

Olympus IX-83 Olympus IX-81 Nikon

Left side port 1 1 5

Binocular 3 2 1

7.2 Observation methods

The setup editor is used to define the observation methods, see section 5.2.2.

In the setup editor you define for each setup the position of the

• Filter block

• Condenser

• Optical path (Camera port, Binocular)

When you change the setup, the motorized microscope will set these three
items to the positions defined in the new setup automatically. The optical path
settings are specific to microscope vendors (see Table 7.1).

Filter wheel position numbers and condenser turret position numbers are
clearly indicated on the microscopes.

A fast switch from any camera port to binocular and backwards is performed
in the menu

Microscope→Binocular

or by pressing F7 .

7.3 Objective control

In the objective editor, see section 5.2.3, you can save nosepiece position
number and the lamp voltage used.

When changing the objective the corresponding nosepiece position and lamp
voltage will be established automatically by the microscope. Nosepiece posi-
tion numbers are clearly indicated on the microscopes.

The lamp voltage setting may be different for different objectives. Therefore
it is recommended to enable the per-objective camera white balance setting
(see section 5.3.2).
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7.4 Z drive control

CellTools features built-in focusing aids and functions that rely on motorized z
drive control. These are:

• Sample plane definition

• Automatic focus adjustment objective and slide change and caplift oper-
ation (CellCut only)

• Focus memory for shapes (CellCut only) and pin positions (see sec-
tion 6.2.8)

• Focus memory for pin positions

mmi CellTools offers three ways to manually focus the z drive:

1. Using the vertical slider on the right-hand side for coarse focussing;

2. Using the two arrow buttons at each end of the slider for fine focusing
and

3. Using the mouse wheel.

In order to use the mouse wheel for focusing, click the mouse wheel focus
button. While the button is activated, the mouse wheel is linked to the micro-
scope z-drive.

Of course, it is possible to refocus using the microscope’s built-in focusing
controls.

When using the manual focus wheel on the microscope, some
microscope models may not feedback the changed focus values
into the software. In order to notify CellTools that the focus has
changed, click on the numerical focus display below the slider to
update its value.

7.4.1 Required calibrations

To estimate the correct focus position requires:

• Correctly measured location of the membrane slide in three dimensions
→ Sample plane definition

• Correctly measured z-drive offsets for

– mmi IsolationCap up / down
– different objectives
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7.4.2 Sample plane definition

The sample plane focus mechanism is a simple focussing aid based on the
assumption that the sample is planar, but slightly tilted against the horizontal
plane of the stage. As a consequence, the focus always lies on this plane,
which can be defined by three points on the slide (see Fig. 7.1).

1

2

3

Figure 7.1: Definition of a tilted sample plane. Given three arbitrary base points (1, 2
and 3), the software computes the tilt angles α and β with respect to the horizontal
plane.

When moving to a different location on the slide, the focus is automatically
adjusted according to the sample plane definition.

While plane tilt focussing is a useful focussing aid on glass slides
and for small areas of interest, the approach is limited. By prin-
ciple, this method cannot compensate for rugged and non-planar
surfaces. For such samples, it is recommended to switch plane tilt
focussing off (see below).

To properly define a plane in three dimensions, three points must be set.
These points should not be on a line. To get most precise results use a high
magnification objective for this procedure (20x or higher).

Figure 7.2: Plane tilt user interface
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Procedure

1. Move to a location near the edge of your sample and focus the micro-
scope.

2. Select Define plane point 1 from the plane tilt menu (Fig. 7.2) or press
Ctrl + 1.

3. Move to a second suitable location and focus.

4. Select Define plane point 2 or press Ctrl + 2.

5. Move to a third suitable location and focus.

6. Select Define plane point 3 or press Ctrl + 3.

7. Repeat this procedure for any other slide on the tray.

Note that the positions of the plane points are displayed in the overview scan.

After the plane is defined, the sample plane focussing aid can be switched on
and off through the plane tilt button or menu (Enable plane tilt focussing). Any
of the three points can be redefined individually afterwards to refine the plane
definition.

The orientation of the sample plane is stored independently for
each slide. When changing to a slide, for which no sample plane
has been defined, plane tilt focussing will be disabled.

You may use Reset plane tilt to remove all points and start defining a plane
from scratch.

7.4.3 Z drive offset calibration for objectives

Each objective needs a different position of the Z drive. To calibrate the objec-
tives use the following procedure:

Procedure

1. Start with the objective with highest magnification

2. Focus microscope

3. Select another objective with closest magnification factor

4. Focus microscope

5. Select menu item
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Microscope→Z Drive Offset→Objective (parfocal)

6. go to step 3) until you calibrated all objectives.

After successful calibration the scope does not lose focus when you change
the objective.

7.4.4 Z drive offset calibration for cap up/down

When you lower the cap on the membrane, the cap will press down the mem-
brane by a few microns. This distance can be measured and corrected auto-
matically:

Procedure

1. Lower cap on membrane

2. Focus microscope

3. Lift cap up

4. Focus microscope

5. Select menu item

Microscope→Z Drive Offset→Cap

or press the keyboard function button F3.

After successful calibration the scope does not lose focus, when you lower or
lift the cap.

7.4.5 Automatic Z drive control

Each time you move the stage with the arrow keys or mouse the best Z drive
position will be calculated and the Z drive motor moved to that position. With
flat samples you immediately receive a sharp image. The more uneven the
sample is, the more you need to correct the Z position manually.

If you draw a shape or if you set a pin position the software saves the z position.
Each time you go back to the shape or the pin position, the saved Z position
will be recalled. You never need to refocus during cutting.
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7.4.6 Z drive offset for slide

In the case of a slide which is non-planar, it is necessary to define a Z drive
offset for the current area. This distance can be measured and corrected
automatically.

Procedure

1. Focus microscope

2. Select menu item

Microscope→Z Drive Offset→Slide

or press F8.

After successful calibration the scope does not loose the focus, when you
change the position of the stage slightly.

7.5 Microscope safety parameters

mmi CellTools provides functions to help prevent physical damage to the mi-
croscope objectives. These functions are always in place and do not require
manual intervention. However, under certain circumstances, they can be con-
figured through the safety parameters dialog.

Figure 7.3: Microscope safety parameters

Open the dialog using the menu item

Microscope→Safety parameters. . .
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7.5.1 Objective collision prevention

There are two situations in which mmi CellTools automatically lowers the ob-
jective turret to prevent potential damage to the objectives:

The first situation is when switching to another objective. This function is car-
ried out automatically and does not require configuration.

The second situation is when moving the stage to a different slide. If the two
slides are not perfectly aligned the surface of the objective may scratch against
the slide’s lower surface. To reduce the risk of damage, the objective turret is
lowered by a certain amount, which can be specified in the safety parameters
dialog (Slide-to-slide motion). If the slides used in your setup exhibit very high
tolerances you may wish to increase this value.

When you are using the small step arrow keys or the mouse the z drive escape
function is switched off.

7.5.2 Objective-sample collision

To prevent contact between the objectives and the specimen and to protect
the microscope itself, the range of the focus drive is automatically limited to
a certain maximum value, which can be specified in the safety parameters
dialog.

To use the current focus setting as objective-sample collision limit, press the
Read current button. To reset the limit to its default value, press Reset.

The recommended procedure for setting the objective-sample collision limit is:

Procedure

1. Select the objective with the shortest working distance (normally the ob-
jective with the highest magnification)

2. Focus the microscope

3. Open the safety parameters dialog:

Microscope→Safety parameters. . .

4. Press the Read current button

5. Add the working distance in µm to the displayed value and go to step 8,
or if the working distance is unknown proceed with step 6.

6. Carefully move the objective as close as possible to the specimen with-
out touching it.
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7. Write down the value displayed under Objective-sample collision.

8. Press the Read current button again.

9. Now enter an Objective-sample collision limit half-way between the two
positions.

10. Click OK

7.6 Fluorescence shutter control

If installed, the microscope’s epifluorescence shutter can be opened and
closed via software. Select

Microscope→Shutter

or press F6.
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8 Image analysis using mmi
CellExplorer

mmi CellExplorer is an optional image analysis software module for mmi Cell-
Tools. It was developed to find, count and measure microscopic objects for
subsequent extraction or manipulation. A carefully selected and application-
adapted set of functionalities guarantees a high throughput at a comfortable
level of automation. Nevertheless, a high degree of flexibility is supported.

The mmi CellExplorer finds, counts and sorts objects primarily based on the
object colors. Secondly, the automatic distinction of various object shapes
is a particularly innovative feature. Round shapes (undifferentiated cells),
for instance, can be automatically distinguished from oval forms (differenti-
ated cells). Objects adjacent to each other are automatically separated and
counted by the software. Finally, the object shapes found can automatically be
optimized for laser cutting.

For advanced users the mmi CellExplorer comprises complex image pre-
processing that can be performed before the object finding. For this pur-
pose the software has many different filters like image sharpness, color inten-
sity, brightness, color space transformations, background separation by fast
Fourier transformations, gamma corrections.

8.1 Getting started

Switch from mmi CellCut or mmi CellEctor to the mmi CellExplorer by choos-
ing the mmi CellExplorer tab. The live image is loaded to the mmi CellExplorer.

8.1.1 Encircling objects of one uniform color

By clicking on the plus left to the color label the small color panel (Fig. 8.1)
opens.

This panel shows eight fields representing eight different object types you can
search for.

93



8. IMAGE ANALYSIS USING MMI CELLEXPLORER

Figure 8.1: Color panel

Move the mouse cursor onto the displayed image and left-click on the color of
the object you would like to count. The color will be displayed on the left side
of the first of the eight color fields in the settings panel.

left-click

right-click

Figure 8.2: Detecting objects of uniform color

With a left mouse click, the color under the cursor will be entered into the
left side of the first color field. The computer would search for all objects with
color ranging from green to white. The gradient in this color field displays the
“search color”.

A right mouse click will choose the “end-color” of the color gradient to search
for. In our case of a unicolored object select the same object with a left and
the right mouse click. The color field will now be filled with green only. Only
green objects will be searched for.

A left and right mouse click onto a unicolored object searches unicolored
objects with the same color (Fig. 8.3).

If the objects are small, it can be tricky to hit the right color. By using the zoom
options of the mmi CellExplorer (section 8.2.2) the selection will be very easy
and precise.
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Figure 8.3: Detecting objects of uniform color: Resulting objects

8.1.2 Encircling Objects with different uniform colors

In order to search for objects with different colors you need more than one
color field. Corresponding to the eight color fields, you can define up to eight
object types for your search. In order to define the colors for those objects
activate the respective color field:

Activate the field for color editing with a left-click. Only one color field can be
edited at once. The outer frame of the color field indicates the selection status
(black for active, light gray for inactive)

Activate/deactivate the field for object search with a right-click. The inner frame
of the color field indicates the status (see section 8.2.3.4).

You can find, count and calculate objects with different colors separately with
the mmi CellExplorer software (see Fig. 8.4).

8.1.3 Encircling Objects with color gradients

Many objects show a color gradient. The mmi CellExplorer can detect them
as well as uniform colored objects. Select the start color of your gradient with
a left-click and the end color with a right-click. Differing brightness or intensity
of the same color can form the gradient too.

Note: Only activated color fields will be used for object search.
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Figure 8.4: Two colors selected

(a) Color field (b) Result

Figure 8.5: Green was selected with the left mouse click, red with the right mouse
click. The selection is displayed in the color field as a gradient. All colors contained
in the gradient will be searched for during a calculation.
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8.1.4 Transfer to other mmi CellTools modules

After selecting your colors, click on the calculate button (green arrow) in the
process toolbar. The software will now search and mark your objects. Please
wait until the process has been completed. This can take a while for large
images.

To return to the main application, click the Return to application button at
the top of the CellExplorer panel. After switching back all detected cells are
lined out and stored in the group statistics. Now you can start the cutting or
collecting process of all marked specimens.

8.1.5 Optimization of results

If your result is not totally satisfactory you can optimize each step of the object
detection. Please refer to section 8.2.

The settings for optimizing the object detection procedure described herein
can be executed directly in the respective section of the Settings panel.

8.1.6 Result lists

8.1.6.1 Object list

The following information is available via the menu item

View→Object list

after each object detection. It displays the calculated parameters like diameter,
total area, circumference and roundness for each detected object.

8.1.6.2 Count list

Under the menu

View→Count list

the count list shows a summary of the detection results. The table lists the
number of objects as well as relative area, sample information and respective
calculated objects per unit in your sample.
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Figure 8.6: Object list

Figure 8.7: Count list

8.2 Reference

Once the CellExplorer tab is selected in the component control panel of the
mmi CellTools main window, CellExplorer becomes the active component. It
adds its own menu items group in the main menu and shows its own control
panel.

8.2.1 Menu reference

The CellExplorer menus consists of four main-menu groups:

• File

• Edit

• View

• Tools

The main menu “Tools” is not used yet. It is reserved for future use.

8.2.1.1 File Menu

Open Opens the window for opening a saved counting session
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Save Quick save of the current counting session, when it has already been
saved before

Save as . . . Opens the window for saving a counting session

Printer Setup Opens the window for printer setup

Open Image file Opens the window for loading a photo

8.2.1.2 Edit Menu

Copy Copies the current photo to the clipboard of your PC

Undo Cancels the last change of settings

Reset Resets the current photo to its initial state

Calculate Starts the analysis

8.2.1.3 View Menu

Image View Shows the current photo

Object List Shows the object list

Count List Shows the count list

Panel/Settings Switches the panel between settings and projects (see sec-
tion 8.2.4)

8.2.1.4 Tools Menu

The main menu “Tools” is not used yet. It is reserved for future use.

8.2.2 Zoom function

The mmi CellExplorer contains a comfortable zoom algorithm. Moving the
slider on the right hand side of the displayed image zooms the image in or out.

With the zoom in function the mmi CellExplorer zooms into a specific part of
your image. Draw a rectangle over the respective area with the mouse button
held down. The mouse pointer will change to a cross shape.

With the zoom out function the mmi CellExplorer zooms out to the original
image size.
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zoom in

zoom out

zoom slider

Figure 8.8: Zoom controls

8.2.3 Control panel

The mmi CellExplorer controls are subdivided into control panels that can be
opened and closed on demand by clicking on the button to the left of the
panel’s title (Fig. 8.9).

Figure 8.9: The mmi CellExplorer control panel for cell recognition

Most panels contain a preview button. When clicked, CellExplorer will perform
all calculations defined on the respective tool panel on the original image. Use
the button to check the settings you have defined so far.
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8.2.3.1 Process tool panel

The process panel (Fig. 8.10) contains the following controls (from left to right):

Figure 8.10: Process panel

Undo Undo the last change when editing settings

Reset Reset the current photo to its initial state

Calculate Performs a complete analysis on the current image using all pa-
rameters defined in the control panel. After this calculation, the objects
can be transferred to mmi CellCut or mmi CellEctor.

Objects Displays the number of counted objects.

8.2.3.2 Settings profile panel

Save your settings by entering a name in the settings profile toolbar and click-
ing Save.

Figure 8.11: Settings profile panel

8.2.3.3 Advanced imaging panel

The advanced imaging functionalities allow preprocessing and optimizing the
image before an object search is performed.

Figure 8.12: Advanced imaging panel
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Smoothing You can smooth your image with the smoothing function in order
to round over edges and achieve a better counting and splitting result. By
adjusting the Smooth radius slider, you can define the level of smoothing.

The radius used for the calculation of the smoothing can be set with the slider:

• 0 is a small radius

• 10 is a large radius

By clicking the Check button, you can verify the effect.

Image Effects For manipulation of digital images, the mmi CellExplorer con-
tains additional image editing algorithms. Pressing the Image Effects button
opens a dialog (Fig. 8.13). You can see two small versions of your image. The
left image shows a copy of the original, while the right one directly displays the
effects of the changes made by adjusting the controls.

Figure 8.13: Image effects dialog

How to use the combination of several image effects:

Evaluate the best set of image effect parameters:
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Procedure

1. Open the Image Effect panel

2. Change a parameter and press Copy Results to Original

3. Change as many effect parameters and press Copy Results to Original
until you found the best set of parameters

4. Close

Set the best set of image effect parameters for the use in combination with the
green arrow key

Procedure

1. Open the Image Effect Panel

2. Set the best set of parameters without using the Copy Results to Orig-
inal buttons and close the Image Effect Panel with the OK button.

Contrast and Brightness Optimize the image contrast and brightness by adjust-
ing the sliders.

The HSV register The HSV register contains further important functions for
image editing. It mainly helps with manipulating color images with a color
depth of up to 32 bits. The three sliders modify the hue, saturation and inten-
sity/value. New colors are defined with the cursor in the color field located at
the lower part of the register. The primary colors are defined with the rainbow
tool displayed in the larger part of the window.

The HSL register In the HSL register, you can further adjust the colors, apply-
ing the same principles as described for the HSV register.

The RGB register In the RGB register, you can control the individual primary
color values. All true colors can be modified by adjusting the three sliders for
red, green and blue.

The Equalization register In the Equalization register, halftones can be con-
trolled exactly. The distribution and frequency of the halftones (0–255 for 8-bit
images, 0–65535 for 16-bit images) is displayed in the histogram. By adjust-
ing the sliders, halftone ranges can be shielded from the image. Just move the
slider with the left mouse button held down. You can also edit color images.
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Just click into the small windows below the word “histogram”. The respective
primary color will be displayed. Now the individual distribution of the colors
red, green and blue (RGB) can be filtered.

Bump Map filter The Bump Map Filter produces a surface structure like those
of freeze-cuts. It simulates a metallic surface where objects show high con-
trasts. You can control the illumination from punctual to flat by adjusting the
sliders left/right (Left) and top/down (Top). You can also dye the surface. In
order to do so, just move the mouse pointer within the color window.

In case you would like include the original colors of your object into the metallic
surface, increase the percentage value below the Source image quantity.

Fast Fourier Transformation The fast fourier transformation searches for edges
in the image. This transformation can mainly be used to reduce background
noise.

Gamma correction The Gamma correction is a special brightness and contrast
Special function. Especially very low light images can be improved by using
the gamma correction.

Sharpen With the sharpen function you sharpen the contour of the objects.

8.2.3.4 Color tool panel

Figure 8.14: Color panel

Color fields for different object types Open the color panel to choose up to eight
color gradients as settings for counting eight different object types. This en-
ables you to find, count and measure object types with different colors simul-
taneously; the counting results are shown separately for each color. The color
fields are characterized in Fig. 8.15.
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(a) Color field inactive for
editing and inactive for ob-
ject searching

(b) Color field active for edit-
ing (only one color field can
be edited at once), but inac-
tive for object searching

(c) Color field active for ob-
ject search but inactive for
editing.

Figure 8.15: Color fields state indicators

Standard color selection With a left mouse click on the displayed image, the
color under the cursor will be entered into the left side of the first color field.

Figure 8.16: Standard color selection

A right mouse click on the displayed image will choose the “end-color” of the
color gradient to search for.

If the objects are small, it can be tricky to hit the right color. By using the zoom
options of the mmi CellExplorer as described in section 8.2.2 the selection will
be very easy and precise.

Advanced color selection With a double left mouse click in the right or left part
of the color field a standard color menu is opened to select a new colour for
the right or left part of the color field. Select the Custom file card in the Color
menue to customize the favoured color.

The Power slider (Fig. 8.14) adjusts the intensity of the marking. You should
try to get homogeneous dark objects and a light background

• 100 is the lowest intensity

• 0 is the strongest intensity

Important: Please try to obtain objects as dark as possible!

Multimode If multimode (Fig. 8.14) is selected the parameters in the lower
setting panels defining the object shape, like object area, object roundness. . .
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(a) Standard colors (b) Custom colors

Figure 8.17: Advanced color selection

will be handled separately for each color set. If multimode is not selected the
set of shape parameters will be applied to all color sets.

8.2.3.5 Mark tool panel

After selection of the colors the image will appear as a black and white image.
The darker the pixels are the better will the color match the selected color.

Figure 8.18: Mark tool panel

In the Mark tool panel (Fig. 8.18) objects can be separated from the surround-
ings of similar color by adjusting Sensitivity:

• 0.01 is the lowest intensity

• 1.00 is the strongest intensity

The Background suppression filters the background:

• 1 means low filter suppression

• 20 means high filter suppression

For small objects high filter suppression is recommended, while large objects
should be selected with a low filter suppression.
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By applying the Mark function the candidate pixels for an object will be labeled
red.

Important: Please try to mark all objects in red with a white back-
ground.

8.2.3.6 Split tool panel

The mmi CellExplorer contains a mode for automatic splitting of objects. In
microscopic images of cells or structures the relevant objects are often located
next to each other in a way that the computer detects those objects as one
single structure. The toolbar split is used for separating these overlapping
objects:

Figure 8.19: Split tool panel

For the separation of overlapping objects activate the box Split.

Adjusts the intensity of the split factor:

• 0 is a low split factor

• 1 is a high split factor

The Min line slider selects the shortest length of the split line. If you select
a very small value, many small segments of larger objects are separated as
individual objects. If you enter a very large value, overlapping objects are no
longer separated.

The Max line slider selects the longest length of the split line. The value is
preset to maximum. If large individual objects are separated into two parts,
you have to decrease the value.

The split feature allows the separation of overlapping objects. The feature
Singlesplit separates objects once, while the feature Multisplit cross-checks
after separating whether another separation of the objects is necessary. Sep-
arating with Multisplit is time-consuming!
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8.2.3.7 Find tool panel

With the find tool panel you may adjust the size and roundness of the selected
objects.

Figure 8.20: Find tool panel

Min area and Min diam define the smallest object area and diameter, which
are counted. Max area and Max diam defines the largest object size and
diameter, which are counted.

Use Min c/a and Max c/a to filter by roundness: All objects with roundness
between the Min c/a and Max c/a value are counted.

Definition of the roundness in mmi CellExplorer :

c
a

=
circumference2

4π · total area
(8.1)

The roundness will separate different geometrical shapes such as circles,
squares, rectangles and ellipses. The results are independent from shape
size and allow you to separate shapes by geometry.

Attention: In binary images, objects appear as a collection of pix-
els; therefore, objects are never entirely round or rectangular.

Table 8.1: Roundness of simple objects

geometry roundness

circle ≈ 1.0

square ≈ 1.5

rectangle ≈ 2.0

ellipse, 1:2 ≈ 4.0
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(a) Original image

(b) Results

Figure 8.21: Example for calculating the roundness of different objects independent
from size

8.2.3.8 Shapes toolbar

With the shape toolbar the contours of the selected objects can be optimized.

Figure 8.22: Shapes tool panel

The Factor defines a percentage correction of the shape size:

• Factor < 1.00: reduction of the shape size (Min: 0.8)

• Factor = 1.00: no correction

• Factor > 1.00: increase of the shape size (Max: 1.2)
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The Constant parameter adds a pixel correction to the shape size:

• Constant = 0.00: no pixel correction

• Constant > 0.00: shape size increases by “constant” pixels (Max: 50)

The pixel correction can be used to compensate for the laser cutting width
independent from the object size.

With the Smoothing feature the contours of the selected objects can be
smoothed:

• Smoothing = 0: no smoothing

• Smoothing > 0: increase smoothing of object contours (Max: 100)

8.2.4 Project panel

The mmi CellExplorer project panel shows all images contained in the current
session. You can choose whether the image is displayed in the work image
panel using the checkboxes on the left of the images. You can also delete an
image from the current session by marking it with the mouse and clicking the
Delete button.
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9 Maintenance

9.1 System check

• Visually inspect the housing periodically to verify that no panels are loose
or distorted so as to allow access to laser or electrical energy in the
interior.

• Verify the correct operation of the LEDs by simulating their functions.

9.2 Cleaning

Caution

• Before cleaning the system, disconnect all system components from the
mains. OR

• Before connecting all system components to the mains again, ensure
that all positions in the objective turret that do not contain an objective
lens are covered with blanks and that the beam path covers and the laser
box are not disconnected.

• Laser power up to 15mW at 355nm is accessible in the interior, if a cover,
an objective, a blank to cover an unused hole in the objective turret or
the laser box is removed or opened.

9.2.1 Microscope

For further details, see microscope manual.

OR
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9.2.2 Cleaning when actually dirty

Actual dirt, e.g. caused by fingerprints or immersion oil, must be removed
immediately or the optical functions will be permanently impaired. Dirt that
has been burnt onto the surface of lenses or filters by laser light can no longer
be removed.

• Lightly moisten a cleaning tissue with pure alcohol (70-80%) or spirit and
wipe the dirty parts very carefully

• Clean dry objectives and oculars gently with a cotton bud or a cotton
wool wrapped around a toothpick; Only use surgical cotton from the
pharmacy

• Remove cotton lint and fluff by blowing, e.g. with an enema syringe

Caution

• Moisten cleaning tissue only slightly, do not soak; Excessive solvent
might dissolve the cement of the lenses

• Do not use acetone for cleaning under any circumstances

9.3 Trouble shooting

This section provides support for problems that can occur when working with
the mmi CellTools. Most of the problems can easily be solved by the user.

9.3.1 View

No image on the monitor

• The microscope camera port switch should be set towards the camera
(default is left side port)

• The camera exposure time is much too low

• The camera cables are not connected properly

The image is not clear, too dark, too bright

• check the camera setup
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• Check that there is sufficient illumination from the white light and that the
light path is not obstructed

• Check that the correction ring of the objective is on the value 1 (corre-
sponding to glass thickness)

• Use the diffuser for improved image quality

• Calibrate the camera in the z-axis

The colors are wrong

• Set white balance

• A fluorescence filter is still turned into the light path

9.3.2 Movement

The stage moves a large distance very fast when using the mouse, or stage
movement does not follow mouse.

• Wrong objective selected

• Camera alignment not correct (see section 5.7.1)

• The camera is not mounted in an exactly upright position

Live image does not follow the hand, if moving stage with the mouse:

• Wrong objective selected

• Camera alignment not correct (see section 5.7.1)

• The camera is not mounted in an exactly upright position

Image not in focus after objective is changed (for automated microscope only)

• Parfocal lens offset not correct.

Displacement of markers after objective is changed:

• Paraxial lens offset not correct.

Overview images not matching stage geometry.

• Stage geometry not properly defined, see section 5.5

• Stage origin calibration invalid, see section 5.5.4
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9.3.3 Overview

The stitched image is patchy. Tiles do not match correctly.

• Camera alignment not correct (see section 5.7.1)

• The camera is not mounted in an exactly upright position

9.3.4 Drawing

The drawing line is difficult to see

• Choose dark line colors for bright samples and bright line colors for dark
samples

• Increase the thickness of the line if necessary

9.3.5 Cutting

9.3.5.1 Standard test procedure

Procedure

1. Mount a MMI membrane slide with a supporting microscope slide into
the slide holder.

2. Set the cutting speed, the focus and the power to the values given in
your system test report delivered with your mmi CellCut

3. Cut 10 circles

Following actions could be required:

• The circles a well cut: no further action required

• The cutting is not homogeneous or not complete: Probably the laser
power dropped down, please contact your service representative

• The cutting line is not closed on the left edge: Probably the stage accu-
racy is critical, please contact your service representative
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9.3.5.2 Cutting problems

No cutting can be observed

• The laser has not been switched on (key and button)

• The magnification chosen does not correspond to the objective in use.

• The laser power is too low

• The laser focus is not well adjusted

The cutting is not perfect; bridges remain in the cutting path

• Repeat the cut if necessary

• The cutting speed is to high

• The illumination pillar is not set upright and the interlock switch can’t
close

The cutting is not clean; The cutting width and the laser spot can be seen on
the video image during the cutting process

• The sample is too wet

9.3.6 Collection

The dissected objects are not collected.

• The cap is lowered onto the metal frame and does not contact the mem-
brane properly.

• Cutting was not complete and successful. Adjust laser settings or select
repetitions to achieve full penetration of the beam through the membrane
and tissue.
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A Service

Service should only be performed by qualified MMI personnel or our desig-
nated representative(s). The MMI system contains no user-serviceable parts.

For questions about your instrument (technical, consumables, warranties)
please contact:

Europe and Asia:
B Molecular Machines & Industries AG (MMI)

Flughofstrasse 37
8152 Glattbrugg
Switzerland

T +41 – (0)44 – 8 09 10 10
u +41 – (0)44 – 8 09 10 11

North America:
B MMI Molecular Machines & Industries Inc.

P.O. Box 348
Haslett, MI 48840
USA

T +1 – (603) 629 9536
u +1 – (321) 978 0304

m www.molecular–machines.com

k service@molecular–machines.com
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B List of Keyboard Shortcuts

General

+ Move to next shape . . . . . . . . . . . . . . . . . . . 42

- Move to previous shape . . . . . . . . . . . . . . . . . 42

Caps Lock Suppress continous stage movement . . . . . . . . . 38

Ctrl + C Copy shape . . . . . . . . . . . . . . . . . . . . . . . . 59

Ctrl + Del Delete all shapes . . . . . . . . . . . . . . . . . . . . . 59

Ctrl + I Show stage insert . . . . . . . . . . . . . . . . . . . . 42

Ctrl + M Fire laser for timed interval . . . . . . . . . . . . . . . 61

Ctrl + O Set stage origin . . . . . . . . . . . . . . . . . . . . . . 47

Ctrl + P Stage movement settings . . . . . . . . . . . . . . . . 38

Ctrl + Shift + Del Delete all shapes from current group . . . . . . . . . 59

Ctrl + Shift + M Fire single laser pulse . . . . . . . . . . . . . . . . . . 61

Ctrl + V Paste shape . . . . . . . . . . . . . . . . . . . . . . . 59

Del Delete shape . . . . . . . . . . . . . . . . . . . . . . . 59

End Move to last shape . . . . . . . . . . . . . . . . . . . . 42

Esc Interrupt current process . . . . . . . . . . . . . . 40, 51

F1 Display user manual . . . . . . . . . . . . . . . . . . . 52

F2 Lower or raise cap lift . . . . . . . . . . . . . . . . . . 26

Home Move to first shape . . . . . . . . . . . . . . . . . . . . 42

Space Switch between moving and drawing mode . . . . 37, 55

Camera control

Ctrl + R Open camera settings . . . . . . . . . . . . . . . . . . 32
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List of Keyboard Shortcuts

Ctrl + S Save an image . . . . . . . . . . . . . . . . . . . . . . 34

Ctrl + W Set white balance . . . . . . . . . . . . . . . . . . . . 34

Microscope control

Ctrl + 1 Define first sample plane point . . . . . . . . . . . . . 87

Ctrl + 2 Define second sample plane point . . . . . . . . . . . 87

Ctrl + 3 Define third sample plane point . . . . . . . . . . . . 87

F3 Define Z drive offset . . . . . . . . . . . . . . . . . . . 88

F6 Open/close fluorescence shutter . . . . . . . . . . . . 91

F7 Switch between camera and binocular . . . . . . . . 84

F8 Define z drive offset for current slide . . . . . . . . . . 89

Navigation

Insert Home Page
Up

Page
Down

Del End

0

1 2 3

4 5 6

7 8 9

.

Num
Lock

/ * -

+

Enter

move to 
previous shape

move to 
next shape

move to 
first shape

move to 
last shape

delete 
shape

press: minor steps
hold: slow movement

press: major steps
hold: fast movement
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C Technical data

C.1 Required minimum workspace

The table top for the microscope, laser, optical equipment, computer monitor
and keyboard requires a minimum workspace of 1.20 m × 0.90 m.

The computer should be positioned under or near the table. The camera–
computer connection cable is 2 m long to ensure reliable data transfer.

C.2 System components

C.2.1 Microscope

Inverted or upright research microscope with fluorescence port.

Supported microscope models:

• Olympus IX-71 (non-motorized)
• Olympus IX-81
• Olympus IX-83
• Nikon Ti (S, U, E)
• Nikon TE 2000 (S, U, E)

C.2.2 Stage

Scanning stage with stepper motors.

Scanning area: 120 × 100 mm2

Repositioning accuracy: < 1 µm

Step resolution: 0.078 µm (CellCut Plus)

0.039 µm (SmartCut Plus)
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C.2.3 Laser system

• Fixed beam
• Extremely sharp focus due to computer simulated optics
• Computer controlled laser power
• Computer controlled laser focus (z-position of the beam)
• Safety devices and eye protection filters

Wavelength: 355 nm

Line voltage: 200–240 VAC or 100–110 VAC, 50–60 Hz, 1,0 A

C.2.4 Digital camera

mmi CellCamera MXF285c

• IEEE1394b (FireWire) color CCD camera
• 2/3" interline transfer frame readout CCD
• Temperature controlled active Peltier cooling
• signal to noise ratio: > 62 dB
• On board integrated color processor for high quality color calculation
• 1392 × 1040 pixels with up to 20fps
• Ultra high sensitivity

mmi CellCamera DXA285cF

• IEEE1394a (FireWire) interline transfer color CCD camera
• 2/3" interline transfer frame readout CCD
• Super HAD technology
• signal to noise ratio: > 56 dB
• 1392 × 1040 pixels with up to 15 fps
• Ultra high sensitivity

mmi CellCamera DXA285F

• IEEE1394a (FireWire) interline transfer CCD camera
• 2/3" interline transfer frame readout CCD
• Super HAD technology
• 1392 × 1040 pixels with up to 15 fps
• Ultra high sensitivity
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Andor iXonEM+ EMCCD Camera 897

• EMCCD Technology: Even single photon signals are amplified above the
noise floor. Full QE of CCD chip is harnessed (no intensifier).

• RealGainTM: Absolute EMCCD gain selectable directly from a linear and
quantitative scale.

• TE Cooling to −100°C: Critical for elimination of dark current detection
limit.

C.2.5 Computer

Suitable computer workstation models are preselected and tested by MMI.
Only use computer hardware supplied through MMI. Before performing hard-
ware modifications, contact service.

mmi CellTools supports Microsoft Windows XP, Windows 7 and Windows 8 in
32-bit and 64-bit configuration.

C.2.6 Cap lift

Classic cap lift

• ± 1 mm moving distance
• Single cap holder

mmi CapLift

• ± 3 mm moving distance
• adjustable cap pressure
• high repositioning accuracy
• Single cap holder

mmi MultiCap

• ± 3 mm moving distance
• adjustable cap pressure
• high repositioning accuracy
• Single cap holder
• Multicapholder
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